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License Agreement
Distribution

B.U.D.S. can be installed on any number of your computers, but it will always need a MPI® and a matching access code 
to be fully operational.

Disclaimer

B.U.D.S. software is provided on an “as is” basis without warranty of any kind, expressed or implied, including but not 
limited to the implied warranties of merchantability and fitness for a particular purpose.

BRP® does not warrant that the operation of the software will be uninterrupted or error free, or that the software 
functions will meet your requirement, or that defects in the software will be corrected.

BRP does not warrant or make any representations regarding the use or the results of the use of the software or any 
documentation provided therewith in terms of their accuracy, correctness, reliability, or otherwise.  No written or oral 
information or advice provided by BRP or a BRP authorized representative create a warranty or in any way increase 
the scope of this warranty.

BRP is not liable for any claims or damages whatsoever.  This include loss of profits, property damage, personal injury, 
intellectual property infringement, interruption of business, or for any special, incidental or consequential damages, 
however caused, whether arising out of breach of warranty, contract, tort (including negligence), strict liability, or 
otherwise.

DESS, LEARNING KEY, RAVE, MPI, VCK are registered trademarks of BRP Inc. and/or its subsidiaries.

All other trademarks and service marks are the property of their respective owners.
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General Characteristics
B.U.D.S. is a comprehensive multi-language diagnostic software that gives you an insight on BRP® electronic 
modules. 
Using B.U.D.S., you can:

Edit vehicle information•
Test, add or remove DESS® keys•
Adjust engine parameters•
Activate module outputs•
Stop the engine•
Monitor vehicle parameters•
Troubleshoot vehicle faults•
Replace a module•
Update a module•
Read and reset historical data•
Save vehicle information to disk•
Print vehicle information•
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System requirements
The following list defines the minimum requirements that your PC must meet in order to run B.U.D.S.

486 processor or higher (Pentium recommended)•
Windows 95/98, NT 4.0, ME, 2000 or Windows XP operating system•
10 MB of hard disk space (Compact), 20 MB recommended (Typical)•
4 MB of RAM (16 MB or higher recommended)•
VGA or higher resolution monitor (SVGA)•
A mouse or any other pointing device•
For VCK® connection: one unused standard serial port (COM) or one unused USB 2.0 port for USB-to-Serial•
adapter.
For MPI-2 interface connection: one unused USB 2.0 port .•
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IXXAT driver installation
B.U.D.S. communicates with the electronic blocks of the vehicle through the MPI ® (Multi Protocol Interface).
Today, there are two models of MPI adapters: MPI-1 and MPI-2 (or MPI-II).

MPI-1 - is outdated adapter, able to work in three main protocols: KW2000-250k, DESS, 947-DI. Communicates with 
the computer via RS-232, also called a COM port. It supports almost all models 4-TEC, which support the exchange rate 
250k KW2000 protocol as well as the entire line of 2-stroke technology. Due to lack of KW2000 protocol with baud rate 
500k is not able to handle E-TEC technology, and some models of ATV Can Am. Since most modern laptops no longer 
has an RS232 serial port, must be used an USB to RS232 adapter. There are many USB-to-RS232 adapters, and each 
has its own driver.

MPI-1 is no longer officially supported in the version 3 and higher.

MPI-2 - a modern USB adapter, which uses the protocol CAN, supports transfer rate of 25 to 1000k. For the diagnosis 
of BRP vehicles used KW2000-250k and KW2000-500k. As a standalone unit, supports 4-TEC and E-TEC vehicles. With 
the additional device DESS Post Interface (P/n 529036019) supports the full range of vehicles BRP, including 2-stroke 
technology.

The latest software B.U.D.S. only works with MPI-2 adapter.

To use MPI-2 adapter with your PC/laptop, driver IXXAT must be installed.
Demonstration of IXXAT driver installation on laptop with Windows 7.

1. Download the IXXAT driver for MPI-2 interface: vci_3_2_2_2098.exe
2. Start the installation by double-clicking on the downloaded installer file.
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Distribution
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B.U.D.S. Installation
1. Start the installation of the program by double-clicking on the downloaded file (BUDS x.x.x.exe).
2. Select the installation language and click “OK«.

3. Follow the instructions and click »Next >«.

4. Carefully read the license agreement, then put the point in the right place and click »Next > ».
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5. Type the »Name« and »Number« of the dealer and click »Next > ».
If you are not a dealer, you can specify any name and number.
These data will only appear on the report of diagnosis, if you want to print a report.

6. Specify your details. These data will appear in the report, if you wish print a diagnostic report.
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1) Username to log into the program.
2) Your First Name (can be any).
3) Your Last Name (can be any).

7. Specify your password to log into the program and click »Next >«.

8. The installation process starts.
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The next step - to install license key.

You need the administrator privileges in order to successfully install B.U.D.S. on Windows NT, Windows 2000 or Windows 
XP.
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B.U.D.S. Demo mode
How to run B.U.D.S. in demo mode. 
1. Launch B.U.D.S..
2. In the window that opens, click »Ignore«.

3. Enter the username and password to access the program interface.

4. Click »Open«.

5. Select demo-file.
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Now you can familiarize with the program.
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License key Installation
!!! VERY IMPORTANT !!!

Each MPI adapter has a unique serial number.
The license key is based on the serial number of the MPI adapter and the current date.
Before you begin to install the license key check the date settings on your computer.
If the date on your computer will not match the actual date the program will tell that you are trying to install the 
wrong license or expired license.

The license key is valid for installation into the program within 24 hours only!

If this condition is met, then use Method 1 (normal).

If you have not installed a license key within the specified period, and the program displays a message that the 
license key has expired, we are recommend to use Method 2 (file “License.dat”).

If these instructions will not help you to solve the problem immediately contact the supplier of your license.
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License key installation (Method #1)
1. Connect the MPI-2 interface to your PC/laptop.
2. Launch B.U.D.S.. Page “Access privileges” will appear.

3. Insert your license key.
We suggest you »copy / paste” the license key to this section.
4. Once the keys have been inserted, click on Add, check the Expiry Date (!) and click on OK button.

You now have Full dealer B.U.D.S. diagnostic system!
If you have installed multiple versions of B.U.D.S., you must repeat steps 2-4 for each program.
One more license.

If a license is already installed and you want to install yet another type of license, do the following steps:
1. Connect the MPI-2 interface to your PC/laptop.
2. Launch B.U.D.S..
3. In the top menu, select MPI®. In the drop-down list, select Privileges... .
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 Page �Access privileges” will appear.

4. Insert your license key.
We suggest you »copy / paste” the license key to section Access Code.
5. Once the keys have been inserted, click on Add, check the Expiry Date (!) and click on OK button.

You now have Full dealer B.U.D.S. diagnostic system!

IMPORTANT NOTE !!!

If you have installed multiple versions of B.U.D.S., you must repeat steps 2-5 for each program.
We have discovered, on some screens the »OK« (red box highlighted above) is not visible at the bottom of the screen! 
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This may be due to screen resolution or computer settings. But license cannot be installed until the »OK« button is 
clicked after entering the key code!
We have found that moving the task bar to a side position usually exposes the top of the button. But in extreme cases 
we have had to resort to changing the screen settings, by temporarily  flip the screen to 90 degrees.  This allows the 
button to be clicked!
Or:
After clicking »Add« button is necessary to press once the TAB key on your keyboard (TAB key is over CAPS LOCK) and 
press the ENTER key.
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License key installation (Method #2)
These instructions will be useful in such cases:
1. License key did not installed within 24 hours and the program reports that the license has expired.
2. You have installed a new version of B.U.D.S. and is necessary to transfer your license to new program.
3. You want to transfer your license key to another computer (buying a new laptop, sale of diagnostic equipment).
4. Falling of Windows operating system on your computer or any other reason related to the performance of your

computer. 
5. Other cases in which it is impossible to install a license key by Method #1.

IMPORTANT!
There are two versions of B.U.D.S. programs:  BUDS P2.3.xx  (hereinafter version 2) and  BUDS x3.x.x  (hereinafter version 3) 
(where xx - the subversion numbers of the program).
It is possible to transfer the license only inside the appropriate version of B.U.D.S. program: license from the 2-nd version can not 
be transferred to the 3-rd version, and vice versa.

How to install a license after 24 hours.

There are two ways to transfer the license using the license file »License.dat«.
First way (easier)
We first consider an easier way.
An easier way - if you have computer with installed license key and you need to transfer the license to a new version of B.U.D.S. 
program or to another/new computer (cases 2 and 3).
1. Prepare your computer.
If you will transfer your license to another/new computer, you must first install IXXAT driver and B.U.D.S. software.
To transfer the license from »old« B.U.D.S. program (let us assume x3.x.x) to the new version , at first install it (new version).
2. On your computer, open the folder with the B.U.D.S. program, which has already installed license.

 Disc C: > Program Files > BRP > BUDS x3.x.x . (In my example BUDS W3.3.3 ).
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3. Copy the file License.dat (or License) to the clipboard (if you want to transfer your license to the new program) or Send to
(flash memory) if you want to transfer your license to another computer.
4. Open the folder BUDSCommon.

 Disc C: > Program Files > BRP > BUDSCommon .
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5. Paste the file License.dat .
That's all.
Second way

Now consider the second way - if you do not have the ability to copy a file License.dat, but you have a license key (cases 
1,4,and 5).

License.dat file can be created manually.

Below is an example of how look like B.U.D.S.'s  license key:
076A-8790-C31A-EE7D-3DBC

1. Prepare your computer (install IXXAT driver and B.U.D.S. software).
2. On an empty part of the desktop, click the right mouse button, select New > Text Document.
3. Open it.
4. Copy your license key into a New Text Document.
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5. Remove all dashes from the text of the key (ex.: 076A8790C31AEE7D3DBC).

6. In the top menu, click »File«.
7. From the drop-down list, choose »Save As...«.

8. Open the folder BUDSCommon.
 Disc C: > Program Files > BRP > BUDSCommon  .

9. Replace the name »New Text Document.txt« on »License.dat«.



B.U.D.S. User Manual Installation > License key

  27www.diag-systems.com

10. Click on »Save«.

That's all. Empty »New Text Document« on the desktop can be deleted.

If B.U.D.S. continues to require a license to install, then reinstall B.U.D.S..
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Terms and Abbreviations
The following table contains a list of terms and abbreviations that are used throughout B.U.D.S.:

Abbreviation  Description
AC  Alternating Current
ADC  Analog to Digital Converter
ATV  All-Terrain Vehicle
BPS  Bits Per Second
B.U.D.S.  BRP® Utility and Diagnostic Software
DC  Direct Current
DESS®  Digital Encoded Security System
ECM  Engine Control Module
ID  Identification
LED  Light Emitting Diode
MB  Mega Byte
MPEM  Multi-Purpose Electronic Module
MPI®  Multi-Protocol Interface
MPI®-2 Multi-Protocol Interface (version 2, modern)
MY  Model Year
PC  Personal Computer
PWC  Personal Watercraft
RAVE®  Rotax Adjustable Variable Exhaust
RPM  Revolutions Per Minute
TPS  Throttle Position Sensor
T.O.P.S.®  Tip Over Protection System
VCK®  Vehicle Communication Kit
VCM  Vehicle Control Module
VIN  Vehicle Identification Number
VTS  Variable Trim System
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Title bar
The title bar at the top of the window identifies which MPEM document the software shows and lets you perform 
many window operations as well.  The title bar is the control point for moving the window and the location of the 
system menu, minimize, maximize, restore and close window buttons.

When a MPEM document is opened, the title bar text is made up of the vehicle type, the MPEM document file name 
and the software name.  When no MPEM document is opened, the title bar text is made of the software name only.
Example
The following example shows the text of a title bar with a personal watercraft MPEM document opened and 
modified:
[PWC] ZZN0123456_991028_1130.mpem - B.U.D.S. [modified].
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Menus
B.U.D.S. provides a menu that you can use to initiate commands.  The menu contains individual choices known as 
menu items.  You can select menu items with the mouse or with the keyboard.  In the later case, press the ALT key to 
activate the menu bar.  Once the menu bar is activated, navigate the menu with the arrow keys and select a menu item 
by pressing the ENTER key.  Some menu items can also be selected directly using keyboard shortcuts (CTRL + key).

The menu bar is composed of the following drop-down menus:
Menu title  Type of commands it contains
File  Primary commands that apply to MPEM documents.
View  Commands that control the appearance of the interface.
MPI®  MPI control commands.
Module  Module control commands.  There is a sub-menu for each module.
Tools  Commands to set the environment.
Help  Commands to assist you with B.U.D.S..
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Read data
B.U.D.S. provides a function that you can use to read a MPEM document from a vehicle.
To read a MPEM document from a vehicle
Select Read Data from the File menu.

or
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Write data
B.U.D.S. provides a function that you can use to write a MPEM document into a vehicle.  Only modified documents 
can be written to the vehicle.
To write a MPEM document in a vehicle
1. Select Write Data from the File menu.
2. Click on the message box OK button.
3. Perform the ECM tracking procedure if necessary.

Or
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Open
B.U.D.S. provides a command that you can use to open a MPEM document from a file.

To open a MPEM document from a file
1. Select Open... from the File menu.
2. Locate the document that you want to open.
3. Double-click on the document file name.
Note

Upon startup, B.U.D.S. looks for MPEM documents in its default »Customers« folder located in your working directory 
(where B.U.D.S. resides).  During a session however, B.U.D.S. looks for documents in the last folder that you saved or 
read a document from.
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Restore
B.U.D.S. maintains a list of MPEM documents that were not successfully written into the vehicle.   The list of 
unsuccessfully written documents can be viewed using the Restore... command.  If the list of unsuccessfully written 
documents is empty or if no vehicle is connected, then the Restore... command is disabled.

To restore a MPEM document
1. Select Restore... from the File menu.

2.
Take a look at the document and target vehicle information to determine if the document 
matches the connected vehicle.

3. If the document does not match the connected vehicle then:
Click on the Ignore button to view the next document in the list.
Go back to step 2.

4. If the document matches the connected vehicle then:
Click on the Restore button to open the document.
Write the document into the target vehicle.

5.
If the document is successfully written into the vehicle, then it is removed from the list of 
unsuccessfully written documents.  Otherwise, the document remains in the list.

Note	
When you launch B.U.D.S. and the list of unsuccessfully written documents is not empty, then the Restore command 
is automatically called.
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Save
B.U.D.S. provides a function that you can use to save a MPEM document to a file.  MPEM document are given a default 
file name that is composed of the vehicle serial number and the computer date and time.  The file name extension is 
'.mpem'.
You are free to change the default file name of a MPEM document.  However, do not change the file name extension.  If 
you change it, then Windows Explorer won't display the icon that makes a MPEM document easily recognizable.
Example file name
ZZN12322311_991020_1120.mpem
To save a MPEM document to a file
Select Save from the File menu.  If the MPEM document is saved for the first time, then B.U.D.S. opens the standard 
Save As dialog to allow you to choose a path name and modify the default file name (See paragraph below).
To save a MPEM document to a new file
1. Select Save As... from the File menu.
2. Locate the folder where you want to save your MPEM document.
3. If required, modify the default File Name that B.U.D.S. created for you.
4. Click on the Save button.
Note
You cannot save a modified document to a file.   Prior to save a modified document, you must write it into the 
vehicle.
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Close
B.U.D.S. provides a menu command that you can use to close a MPEM document without leaving the application.  Closing 
a document clears the interface and stops monitoring vehicle parameters.
To close a MPEM document
1. Select Close from the File menu.

2.

If the document was modified but not written into the vehicle, then B.U.D.S. asks you to 
confirm that you want to continue and loose your modifications.  Choose Yes to close the 
document and loose your modifications or No to cancel the command.

Note
On some vehicles, if the ECM has not yet stored received data in its non-volatile memory, then B.U.D.S. will remind you 
to initiate the ECM tracking procedure.
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Printer setup
B.U.D.S. provides a function that you can use to open the standard Windows printer setup dialog.
To modify the printer setup
1. Click on the Printer Setup... command from the File menu.
2. Change printer Properties to meet your requirements.
3. Click on the OK button.
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Print
B.U.D.S. provides a function that you can use to print MPEM documents.  Printed MPEM documents are referred to 
as Service Reports.
To print a service report
1. Select Print... from the File menu to open the Service Report window.
2. In the Pages to Print group box, check the pages that you want to include in your report.
3. In the Add your Comments zone, type any comments that you want to add to the report.
4. If you want to modify your printer setup, click on the Printer Setup... button.
5. If you want to preview the report, click on the Preview button.
6. Click on the Print button.
Note
You cannot print a modified document.  Prior to print a modified document, you must write it into the vehicle.
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Toolbar
The toolbar provides 8 shortcuts to the most commonly used menu commands. 

The table below shows the toolbar buttons with their corresponding menu commands:

Button  Corresponding menu command
Read Data  File | Read Data
Write Data  File | Write Data
Starting / Stop  Not in menu.  Engine can also be stopped with the space bar.
Open  File | Open...
Save  File | Save
Print  File | Print...
Help  Help | Topic
Exit  File | Exit
To hide or show the toolbar
Toggle the Toolbar command from the View menu.
Note
The toolbar can’t be hidden when the engine is running.
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Status bar
The status bar consists of 5 panels that display status information on the software and the MPEM document being 
viewed. 

The table below describes the content of the 5 status bar panels starting from the leftmost:

Panel name  Content
Date  Your local computer date.
Dealer number  Your dealer number as entered during the installation of B.U.D.S..
Heartbeat  MPI® and Module connection status.  Moving the cursor over the module 

icon indicates which module is present.
Messages  Miscellaneous software messages.
Update  Update indicator.  The icon appears to indicate that there is an update 

available for the connected module.
Faults  Active faults indicator.  The LED blinks to indicate the presence of at least 

one active fault in the module.
To hide or show the status bar
Toggle the Status Bar command from the View menu.
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MPI
The MPI Information window provides you with the following MPI hardware and software information:
Hardware information
Serial Number: MPI manufacturer serial number.

Product Number: MPI manufacturer product number and revision.

Production Date: MPI production date (YYYY/MM/DD).

Software information
Software Number: MPI manufacturer boot loader number and revision.

Control Number: Number stamped into modules when writing 
documents.

Protocol: Protocol currently loaded into the MPI.

To open the MPI information window
Select Information from the MPI® menu.
To close the MPI information window
Click on the MPI Information window Close button.
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Test key
B.U.D.S. provides a function that you can use to test DESS® keys.

To test a DESS key
1. Select Test Key from the MPI® menu.
2. Insert a key on the MPI DESS post.
3. Click on the message box OK button.

Notes
Testing a DESS key while a MPEM document. is opened also indicates if the key has been found in the document or 
not.
Testing a calibration cartridge gives its part number and release date.
Testing a DIAGNOSTIC key results in an open circuit key, error message 252.
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Choose protocol
B.U.D.S. (version 2) for vehicles 1996-2010 supports three communication protocols:  The DESS®, 947-DI, Kw2000  and 
cannot determine by itself which protocol must be used for communicating with a particular module.  It is the user 
who decides when to choose DESS, when to choose 947-DI or when to choose Kw2000 .  If you try to communicate 
with a vehicle using the wrong protocol, B.U.D.S. will simply consider that the module is not present.

B.U.D.S. (version 3) for SeaDoo, SkiDoo/Lynx vehicles since 2007 and all Can Am* vehicles supports Kw2000 (Auto) 
communication protocol only.
The necessary protocol and diagnostic equipment for your vehicle can be determined from the table BUDS Chart .
To choose DESS protocol
1. Select Choose Protocol from the MPI® menu.
2. Select DESS from the Choose Protocol sub-menu.
3. Wait few seconds while B.U.D.S. loads the protocol into the MPI.
4. Verify that the status bar communication icon indicates DESS:

For VCK®:
Using this protocol requires that you connect one end of the DESS adapter in the 6-pin adapter and the other end 
on the DESS post of the vehicle or, on some vehicles, that you connect the 6-pin adapter directly into the diagnostic 
connector of the vehicle.

For MPI-2:
Using this protocol requires that you connect one end of the DESS adapter in the 6-pin connector of DESS Post Interface 
and the other end on the DESS post of the vehicle or, on some vehicles, that you connect the DESS Post Interface 
directly into the diagnostic connector of the vehicle.
If you communicate with a 947-DI using the DESS protocol instead of the 947-DI protocol, then the Monitoring, 
Activation, Faults and History pages will not be available.

* - ATV, SSV, Spyder Roadster

To choose 947-DI protocol
1. Select Choose Protocol from the MPI® menu.
2. Select 947-DI from the Choose Protocol sub-menu.
3. Wait few seconds while B.U.D.S. loads the protocol into the MPI.
4. Verify that the status bar communication icon indicates 947-DI:

The 947-DI protocol is used to diagnose a vehicle equipped with a 947-DI engine.

For VCK®:
Using this protocol requires that you connect the 6-pin adapter directly into the diagnostic connector of the vehicle.  You 
can not use this protocol with the diagnostic cable connected on the DESS® post of the vehicle.

For MPI-2:
Using this protocol requires that you connect the DESS Post Interface directly into the diagnostic connector of the 
vehicle.

To choose Kw2000 protocol
1. Select Choose Protocol from the MPI® menu.
2. Select Kw2000 from the Choose Protocol sub-menu.
3. Wait few seconds while B.U.D.S. loads the protocol into the MPI.
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4. Verify that the status bar communication icon indicates Kw2000:

The Kw2000 protocol is used to diagnose some personal watercrafts and snowmobiles.

For VCK:
Using this protocol requires that you connect the 6-pin adapter directly into the diagnostic connector of the vehicle.  You 
can not use this protocol with the diagnostic cable connected on the DESS® post of the vehicle.

For MPI-2:
Using this protocol requires that you connect the Diagnostic Cable directly into the diagnostic connector of the 
vehicle.

The Kw2000 (Auto) protocol is used to diagnose all modern BRP vehicles.
Only the MPI-2 Interface supports this protocol.
Using this protocol requires that you connect the Diagnostic Cable directly into the diagnostic connector of the 
vehicle.

Note
Upon startup, B.U.D.S. chooses the protocol that you were using when you terminated your last session.
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Choose speed
B.U.D.S. allows your computer to communicate with the MPI® at different communication speeds.  The communication 
speed ranges from 9600 BPS to 115200 BPS.  The default communication speed is 57600 BPS.
B.U.D.S. cannot determine by itself the optimal communication speed for your computer.   If you experience any 
problem, try another communication speed.

To choose a different communication speed
1. Select Choose Speed from the MPI® menu.
2. Select the desired speed from the Choose Speed sub-menu.
3. Wait few seconds while B.U.D.S. changes the MPI communication speed.

Note
Upon startup, B.U.D.S. sets the MPI communication speed to the speed you were using when you terminated your 
last session.
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Privileges 
The Access Privileges window provides functions that you can use to read your current access privileges and add new 
access privileges to your software.

To read your current access privileges
1. Select Privileges... from the MPI® menu.
2. Read the content of the Current Privileges zone.

To add an access privilege to your software
1. Select Privileges... from the MPI® menu.
2. Note the Identification number in the Connected MPI zone.
3. (If you are an authorized dealer) Call your service representative to give him your
Identification number.
4. If you are not an authorized dealer you can buy a license.
5. Type the access code that your service representative will give you in the
New Privileges zone.
6. Click on the Add button.
7. Click on the OK button.
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Reset MPI
B.U.D.S. provides a function that you can use to reset the MPI whenever it seems to be »frozen«.
To reset the MPI
1. Select Reset from the MPI® menu.
2. Wait until B.U.D.S. resets the MPI.
Note
After the reset, B.U.D.S. will automatically reload the protocol into the MPI.
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Module
The Module menu provides functions that you can use to display module informations.  Depending on the type of 
vehicle, the following information pages or windows are available:

MPEM hardware page•
MPEM software page•
MPEM identification page•
MPEM calibration page•
RFI engine module page•
ECM information window•
MPEM information window•
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MPEM Hardware Page
The Hardware page from the MPEM Information window provides you with the following MPEM manufacturing 
information:
Part Number: BRP Part Number (Snowmobile only).

Serial Number: MPEM serial number (not available on all 
MPEM).

Production Date: MPEM production date (YY/MM/DD).

Auto Power-off Delay: Delay before the MPEM turns off after the 
engine is stopped while the key is still inserted 
on the vehicle DESS® post (PWC only).

Product Number: MPEM manufacturer product and revision 
numbers (947-DI only).

To view the MPEM hardware page
1. Read MPEM document from the vehicle.
2. Select Information from the Module | MPEM menu.
3. Click on the Hardware thumbnail from the MPEM Information window.
4. Click on the Close button when you are finished.
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MPEM Software Page
The Software page from the MPEM Information window provides you with the following MPEM information:
Application Number: MPEM family number.

Software Version: MPEM manufacturer software version.

Last Programmer: MPEM-programmer or MPI® control number 
who last wrote the MPEM.

Software Number: MPEM manufacturer full software and 
revision numbers (947-DI only).

To view the MPEM software page
1. Read MPEM document from the vehicle.
2. Select Information from the Module | MPEM menu.
3. Click on the Software thumbnail from the MPEM Information window.
4. Click on the Close button when you are finished.
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MPEM identification page
The Identification page from the MPEM Information window provides you with the following information:
Software: Internal software ID.

Calibration: Internal calibration ID.

To view the MPEM identification page
1. Read MPEM document from the vehicle.
2. Select Information from the Module | MPEM menu.
3. Click on the Identification thumbnail from the MPEM Information window.
4. Click on the Close button when you are finished.
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MPEM calibration page
The Calibration page from the MPEM Information window provides you with the following information:
Calibration Number: Internal calibration ID.

To view the MPEM calibration page
1. Read MPEM document from the vehicle.
2. Select Information from the Module | MPEM menu.
3. Click on the Calibration thumbnail from the MPEM Information window.
4. Click on the Close button when you are finished.
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RFI Engine Module
The RFI Engine Module page from the MPEM Information window provides you with the following RFI engine 
module information:

BRP part number
BRP vehicle identification
BRP software number
RFI engine module number 1
RFI engine module number 2
RFI engine module number 3

To view the RFI engine module page
1. Read MPEM document from the vehicle.
2. Select Information from the Module | MPEM menu.
3. Click on the RFI Engine Module thumbnail from the MPEM Information window.
4. Click on the Close button when you are finished.
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ECM Information
B.U.D.S. provides a function that you can use to display the following ECM information:

BRP Part Number
Rotax Part Number
Revision Number
Hardware Number (not available on all ECM)
Serial Number
Data Modification Fingerprint (not available on all ECM)
Code Modification Fingerprint
Boot Modification Fingerprint (not available on all ECM)
Diagnosis Version Number

To open the ECM Information window
1. Read MPEM document from the vehicle.
2. Select Information from the Module | ECM menu.
3. Click on the Close button when you are finished.
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MPEM information window
B.U.D.S. provides a function that you can use to display the following MPEM information:

BRP Part Number
BRP Software Number
Serial Number
Diagnosis Version Number

To open the MPEM information window
1. Read MPEM document from the vehicle.
2. Select Information from the Module | MPEM menu.
3. Click on the Close button when you are finished.
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Cluster Information window
B.U.D.S. provides a function that you can use to display the following Cluster information:

BRP Part Number
BRP Software Number
Serial Number
Diagnosis Version Number
Calibration Number
Software Number
Code Modification Fingerprint
Vehicle Model
Vehicle Serial Number
Customer Name
Delivery Date
Security Code

To open the Cluster Information window
1. Read MPEM document from the vehicle.
2. Select Information from the Module | Cluster menu.
3. Click on the Close button when you are finished
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Replace window
B.U.D.S. provides a function that you can use to transfer the content of a defective module that you want to replace 
into a new one.
To replace a defective module
1. Read the content of the old module if it is still possible, or open it from a recent file.
2. Disconnect the old module from the MPI®.
3. Connect the new module to the MPI (VCK, MPI-2).
4. Wait until B.U.D.S. sees the module.

Select the Replace command:
From the Module | MPEM menu to replace a MPEM.
From the Module | ECM menu to replace an ECM.

6. Click on the message box OK button.

Note
The Replace command writes the Vehicle, Keys and Part Replacement pages into the new module.  Some Setting page 
parameters are also written.  Other parameters or settings must be initialized manually.  See the shop manual for 
more details.



B.U.D.S. User ManualUser interface > Menus > Module

  58 www.diag-systems.com

Update modul
B.U.D.S. provides a function that you can use to update module’s software.
Every time B.U.D.S. reads a MPEM document from a vehicle, it gets the identification of the module, then it looks in 
its update database to see if it can find a matching software update.  If B.U.D.S. finds an update for the module, then 
it enables the Update... menu and displays the following icon in the lower right corner of the screen:

To update a module's software
When the module identification matches a mandatory update, then the Update command is called automatically.  To 
update the module, simply follow the instructions provided by B.U.D.S..

If for any reason the internal software of the module is corrupted and B.U.D.S. cannot read its identification, then you 
will be asked to enter the vehicle serial and model numbers manually.  In the later case, make sure that you enter the 
exact numbers, otherwise B.U.D.S. could not match the module with its corresponding software update.

B.U.D.S. also allows you to call the Update command manually.  This can be usefull if an update is available for the 
module but the update is not mandatory or if an update process has been interrupted.  To manually intiate the update 
process, follow these steps:
1. Select the Update command:

From the Module | MPEM menu to update a MPEM.
From the Module | ECM menu to update an ECM.

2. Select the appropriate update from the Update Database window.
3. Follow the instructions provided by B.U.D.S..

Notes
Some models may not need to be updated, even if B.U.D.S. shows that an update is available.
Always consult related service bulletins before updating a module's software since you will not be able to go 
backward.
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Technicians
B.U.D.S. maintains a list of users who are allowed to use the software.  Such users are referred to as a registered 
technicians.  Each registered technician is assigned a username and a password.  The password prevents unauthorized 
users from logging into B.U.D.S. and other registered technicians from using somebody else's username.

To add a new registered technician
1. Log on B.U.D.S. as the administrator.
2. Select Technicians... from the Tools menu.
3. Click on the Add Technician button.

4.
Fill in the technician Username, First Name, Last Name, Password and Confirm Password
zones.

5. Click on the Technician window OK button.
6. Repeat step 3 to 5 for each new technician that you want to add.
7. Click on the Registered Technicians window OK button.

To modify a registered technician
1. Log on B.U.D.S. as the administrator.
2. Select Technicians... from the Tools menu.
3. Click on the technician that you want to modify.
4. Click on the Modify Technician button or double-click on the technician.

5.
Modify the technician Username, First Name, Last Name, Password and Confirm
Password zones.

6. Click on the Technician window OK button.
7. Repeat step 3 to 6 for each technician that you want to modify.
8. Click on the Registered Technicians window OK button.

To remove a registered technician
1. Log on B.U.D.S. as the administrator.
2. Select Technicians... from the Tools menu.
3. Click on the technician that you want to remove.
4. Click on the Remove Technician button.
5. Click on the Registered Technicians window OK button.

Notes 
The password must be at least 4 character long while the username, first and last names must be at least 2 character 
long.  The password and names are limited to a maximum of 64 characters each.  You must enter the same passord 
twice to validate it.
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Options
The Options... command from the Tools menu opens the Options window that you can use to change your software 
language and units.  Available languages are English, Finnish, French, German and Spanish.  Available units are metric 
and US.

To change your software language
1. Select Options... from the Tools menu.
2. From the Options window, open the Language drop down list and select your language.
3. Click on the message box OK button.
4. Exit B.U.D.S. and restart it.

To change your software units
1. Select Options... from the Tools menu.
2. From the Options window, open the Units drop down list and select your units.
3. Click on the message box OK button.  New units are taken into account immediately.

Note
Default units are US and default language is English.
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Update database
The Update Database window provides functions that you can use to view or add module updates.
To open the update database window
You can view all updates that are registered in your B.U.D.S. system using the Update Database window. 

To do so, follow these steps:
1. Select Update Database... from the Tools menu.

2.
Use the vertical scroll bar to view all updates.  For each update, the window shows its 
name, date, description and update file name.

3. Click on the Close button when you are finished.
To add an update to the update database

To let B.U.D.S. know about the existence of an update, you must add it to your update database.  To do so, follow 
these steps:
1. Select Update Database... from the Tools menu.
2. Click on the Update Database window Add Update... button.
3. Locate the update file that you want to add. The update file name extension is ‘.fc'.
4. Double-click on the document file name.

Note
Upon startup, B.U.D.S. looks for unregistered update files in its default »UpdateFiles« folder located in your working 
directory (where B.U.D.S. was installed).   If new updates are found, then B.U.D.S. will inform you that they will be 
added to your database automatically.  If previously registered update files are missing, then B.U.D.S. will ask you to 
get these files and add them back to your database.
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Help
B.U.D.S. provides help topics that you can use to solve utilization problems or learn more about the software.  The top-
ics can be browsed using the standard Windows help browser.  B.U.D.S. also provides links that you can use to directly 
open the topics related to the interface component that you are working with.

To open the help browser

Select Topics from the Help menu or click on the Help button from the toolbar.

To open a specific topic
1. Select What’s This? from the Help menu.  Note that the cursor shape changes to an arrow with a question mark.
2. Click on the interface component that you want to open the topic of.

Note
If the interface component that you want to open the topic of is a button or an edit zone, then you can also press the 
F1 key to perform the same action.
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Document area
The document area is where most of the editing and viewing of a MPEM document takes place.  When opening a 
MPEM document, B.U.D.S. displays it in the different pages of the document area.   Each page can be opened by 
selecting its corresponding thumbnail.  The number of pages displayed depends on the type of MPEM document.

The table below shows the different document pages and the information or functions they contain.
Page  Content
Vehicle  Serial numbers, run hours, customer and service info.
Keys  DESS® key functions.
Setting  Engine and vehicle parameters setting functions.
Monitoring  Engine and vehicle monitoring functions.
Activation  Module output activation functions.
Faults  Fault logging and resetting functions.
History  History logging and resetting functions.



B.U.D.S. User ManualUser interface > Document

  64 www.diag-systems.com

Edit MPEM Document 
B.U.D.S. provides functions that you can use to edit MPEM documents.  Most of the editing takes place in the Vehicle, 
Keys, Setting and Part Replacement pages.  When you edit a zone, modifications are done locally in your computer.  To 
reflect the modifications into the vehicle, you must write the modified MPEM document.
To edit a MPEM document
1. Read MPEM document from the vehicle.
2. Edit any of the MPEM document zones.

3. Write MPEM document into the vehicle.

Note
When you edit a MPEM document zone, B.U.D.S. adds the label “[modified]” at the end of the title bar text. The label 
remains there until you write the MPEM document into the vehicle.
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Preview Service Report 
B.U.D.S. provides a function that you can use to preview a service report on your computer screen before you send 
it to a printer.
To preview a service report

1. Open the Service Report window.
2. Click on the Preview button to open the Service Report Preview window.

3.
Click on... To perform the following action

 Zoom service report.

 Navigate service report pages.

 Open the printer setup dialog.  To reflect the change on the screen, close 
the preview window and reopen it.
 Send service report to the printer.

 Save service report to a file.

 Open a service report from a file.
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Vehicle page

The Vehicle page provides functions that you can use to edit vehicle serial numbers, vehicle model and purchase 
information, view/reset run times and last service.  The Vehicle page is common to all BRP® recreational products, 
except the ATV.

To open the Vehicle page
1. Read MPEM document from the vehicle.
2. Click on the Vehicle page thumbnail.
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Serial numbers
The Identification group box from the Vehicle page provides 2 zones that you can use to read/edit* the vehicle 
serial number (VIN) and the engine serial number.  Unlike the vehicle, the engine serial number can be changed at 
anytime.  However when you change the engine serial number on some vehicles, B.U.D.S. automatically logs** the old 
number into the part replacement history.

To change the engine serial number
1. Read MPEM document from the vehicle.
2. Click on the Vehicle page thumbnail.

3. Type the new engine serial number in the Engine zone.
4. Write MPEM document into the vehicle.

Notes
When you write the MPEM document with a new engine serial number, B.U.D.S. asks you to confirm that you really 
wanted to change it.
On some vehicles, the VIN is limited to 17 characters, compared to 20 for others.

* - You can edit VIN if your B.U.D.S. have installed License Key Megatech.
** - You can clear the part replacement history if your version of the B.U.D.S. program have installed License Key 
Megatech.
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Vehicle model
The Identification group box from the Vehicle page provides a zone that you can use to edit* the vehicle model.
To change the vehicle model

1. Read MPEM document from the vehicle.
2. Click on the Vehicle page thumbnail.
3. Type the new model number in the Model zone.
4. Write MPEM document into the vehicle.

Note
The vehicle model must either be “SBOAT”, an alphanumeric value or an entirely numerical value.

* - if your B.U.D.S. have installed License Key Megatech.
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Purchase info
The Purchase group box from the Vehicle page provides an edit zone that you can use to enter the name of the 
customer.  The first time you enter a name in the Customer zone, B.U.D.S. automatically sets the Delivery Date zone 
with your current computer date.  Anytime you further change the customer name, the delivery date zone remains 
unchanged.

To enter the name of the customer

1. Read MPEM document from the vehicle.
2. Click on the Vehicle page thumbnail.
3. Type the name of the customer in the Customer zone.
4. Write MPEM document into the vehicle.
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Run Time
The Run Time group box provides functions that you can use to read/reset* the vehicle total hours and reset the 
vehicle rental hours.

To read the vehicle total and rental hours
1. Read MPEM document from a vehicle.
2. Click on the Vehicle page thumbnail.

3. Look at the Run Time group box.

To reset the vehicle rental hours
1. Read MPEM document from a vehicle.
2. Click on the Vehicle page thumbnail.

3. Click on the Reset Rental Hours button.
4. Write MPEM document into the vehicle.

Note
Rental hours do not exist on all vehicles.

* - You can reset the vehicle total hours on PWC 4-TEC if your B.U.D.S. have installed License Key Megatech.
 How to reset on PWC 4-TEC total hours described on this page.
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Last service
The Last Service group box from the Vehicle page provides functions that you can use to read and reset the vehicle 
service information stored into the module.  The Last Service group box contains the following zones:

Done By: The MPEM-Programmer or MPI® control number who last serviced the 
vehicle.

Date: The date when the last service was done.

Hours: The number of hours the engine had run since the last service.

Resetting the last service information overwrites the Done By zone with your MPI control number, resets the Date 
zone with your current computer date and resets the Hours counter to zero.  On some vehicles, resetting the last 
service information also turns off the maintenance signal of the vehicle cluster.

To reset the last service information

1. Read MPEM document from the vehicle.
2. Click on the Vehicle page thumbnail.

3.
Click on the Last Service group box Reset Service button.  On some vehicles, the button is labelled
Reset Service / “Maint”.

4. Write MPEM document into the vehicle.

Note
Some twin-engine sport boats have 2 more zones to display the last service Date and Hours for each engine.  Also 
provided are the Reset Starboard and Reset Port Side buttons that you can use to reset starboard and port side engine 
date and hours.
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Keys
The Keys page provides functions that you can use to add or erase DESS® keys. 

The Key Usage table shows the status and, when available, the maximum RPM setting (on some 2-stroke) or type for 
each key.

To add a DESS key into the module
1. Read MPEM document from the vehicle.
2. Click on the Keys page thumbnail.

3.
Click on the Add Key button.  For some vehicles, click on the Add Normal Key or
Add Learning Key® button.

4.
Insert a key on the MPI® DESS post (if you work with the VCK®) or* on the DESS Post Interface (if
you work with MPI-2).

5. Click on the message box OK button.
6. Repeat steps 3 to 5 for each key that you want to add.

7. Write MPEM document into the vehicle.

To erase a key from the module
1. Read MPEM document from the vehicle.
2. Click on the Keys page thumbnail.

3. Click on the Erase Key button.
4. Insert a key on the MPI DESS post.

5. Click on the message box OK button.
6. Repeat steps 3 to 5 for each key that you want to erase.
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7.
Write MPEM document into the 
vehicle.

To erase all DESS keys from the module

1.
Read MPEM document from the 
vehicle.

2. Click on the Keys page thumbnail.

3. Click on the Erase All Keys button

4.
Click on the message box OK 
button.

5.
Write MPEM document into the
vehicle.

Note
After erasing all keys, add at least one new DESS key into the document.   If the document contains no DESS key, 
B.U.D.S. will refuse to write it into the module.
* - Connecting the DESS Post Interface with various vehicles.
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Setting page
The Setting page provides functions that you can use to view and modify the vehicle settings.  The content of the 
Setting page depends on the type of MPEM document.

To open the Setting page
1. Read MPEM document from the vehicle.
2. Click on the Setting page thumbnail.

3. Depending on the type of vehicle, the following setting functions are available:
Closed throttle

Closed throttle and idle actuator
Closed TPS

Fuel factor
Ignition correction

Ignition offset
Neutral RPM

Vehicle options
Vehicle variant
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Closed Throttle
The Closed Throttle group box from the Setting page provides a function that you can use to tell the ECM that the 
current TPS value should be considered as the idle.

To reset the closed throttle
1. Read MPEM document from the vehicle.
2. Click on the Setting page thumbnail.

3. Click on the Closed Throttle zone Reset button.
4. Wait until B.U.D.S. confirms that the function succeeded.

5. Perform the ECM tracking procedure.

Note
The adjustment is done simultaneously in the ECM and in the document.
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Closed Throttle and Idle Actuator
The Closed Throttle and Idle Actuator group box from the Setting page provides a function that you can use to tell the 
ECM that the current TPS value should be considered as the idle.

To reset the closed throttle and idle actuator

1.
Read MPEM document from the 
vehicle.

2. Click on the Setting page thumbnail.

3.
Click on the Closed Throttle and Idle Actuator zone Reset
button.

4. Wait until B.U.D.S. confirms that the function succeeded.

5.
Perform the ECM tracking
procedure.

Note
The adjustment is done simultaneously in the ECM and in the document.
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Closed TPS
The Closed TPS group box from the Setting page provides a function that you can use to tell the MPEM that the current 
TPS value should be considered as the idle.
On the RFI engine, the Current Value zone displays the TPS value which is considered as the idle by the MPEM.  On the 
947-DI engine, the Throttle Opening zone displays the real-time TPS value.

To reset the closed TPS

1.
Read MPEM document from the 
vehicle.

2. Click on the Setting page thumbnail.

3. Click on the Closed TPS zone Reset button.

4.
Wait until B.U.D.S. confirms that the function 
succeeded.

Note
The adjustment is done simultaneously in the MPEM and in the document.
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Cluster Setting Group Box
The Setting page provides functions that you can use to view and modify the cluster settings.  The content of the 
Cluster Setting group box depends on the type of MPEM document.

To open the Cluster Setting group box

1.
Read MPEM document from the 
vehicle.

2. Click on the Setting page thumbnail.

3.

Select the appropriate Cluster Pointer Position Adjustement by pressing buttons
Clockwise (to move the pointer 1 step clockwise) or Counterclockwise (to move the
pointer 1 step counterclockwise).

4. Select the appropriate Cluster Mode by pressing buttons Vehicle speed or Engine RPM.

5.
Select the appropriate Cluster Scale by pressing buttons Miles or
Kilometers.
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Fuel Factor
The Fuel group box from the Setting page provides functions that you can use to change the fuel correction factor.
To change the fuel factor
1. Read MPEM document from the vehicle.
2. Click on the Setting page thumbnail.

3. Click on the Factor zone top or bottom arrows to change the fuel correction factor.
4. Write MPEM document into the vehicle.

Note
On some vehicles, two fuel factors are available.
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Ignition Correction
The Ignition group box from the Setting page provides functions that you can use to change the engine ignition 
correction (on some 2-stroke vehicles).

To change the ignition correction

1. Read MPEM document from the vehicle.
2. Click on the Setting page thumbnail.
3. Enter a new Correction value in the Ignition zone or use the corresponding slide bar.
4. Write MPEM document into the vehicle.
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Ignition Offset
The Ignition group box from the Setting page provides functions that you can use to lock and modify the engine’s 
ignition offset angle (on some 2-stroke vehicles).  The Engine Speed zone displays the engine speed in real-time.

To lock the ignition offset angle
1. Read MPEM document from the vehicle.
2. Start the engine and wait until B.U.D.S. considers the engine is idling.

3. Click on the Setting page thumbnail.

4.
Click on the Locked check box and wait until the box is checked.  On a RFI engine, once the
control is checked, B.U.D.S. displays the angle at which the ignition was locked by the MPEM.

To modify the ignition offset angle
1. Click on the Offset Angle zone top or bottom arrows to change the ignition offset angle.
2. Wait until B.U.D.S. writes the new ignition offset angle into the MPEM.

To unlock the ignition offset angle
Click on the Locked check box and wait until the box is unchecked.
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Neutral RPM
The Neutral RPM group box from the Setting page provides functions that you can use to tell the MPEM what are 
the Cutoff RPM and Pickup RPM values of the speed limiter when the vehicle is in neutral position.

To adjust the neutral RPM

1. Read MPEM document from the vehicle.
2. Click on the Setting page thumbnail.
3. Enter a new cutoff RPM value in the Cutoff zone or use the corresponding slide bar.
4. Enter a new pickup RPM value in the Pickup zone or use the corresponding slide bar.
5. Write MPEM document into the vehicle.
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Vehicle Options
The Options group box from the Setting page provides check boxes that you can use to inform the MPEM about the 
optional accessories that are installed on the vehicle.

To modify an option
1. Read MPEM document from the vehicle.

2. Click on the Setting page thumbnail.

3. Click on the check box related to the option you want to turn on or off.

4. Write MPEM document into the vehicle.
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Vehicle Variant
The Vehicle group box from the Setting page provides a function that you can use to change the vehicle variant.

To change the vehicle variant
1. Read MPEM document from the vehicle.

2. Click on the Setting page thumbnail.

3. Click on the appropriate radio button in the Variant zone.

4. Write MPEM document into the vehicle.
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Monitoring Page
The Monitoring page provides functions that you can use to monitor vehicle parameters.
On most vehicles, parameters are monitored in a real-time manner.  It means that once the MPEM document is read 
from the vehicle, B.U.D.S. automatically starts monitoring parameter values at a rate of around two times per second, 
no matter if the engine is running or not.   However, with snowmobile MPEM’s, you are responsible for updating 
monitoring parameters manually by pressing the Refresh button.

For some vehicles, the Monitoring page also provides functions that you can use to momentarily shutdown a 
cylinder or bleed the oil lines.

To monitor engine parameters
1. Read MPEM document from the vehicle.
2. Click on the Monitoring page thumbnail to view engine parameters.

Note
Some vehicles have 2 monitoring pages.  The second page can be accessed using the navigation buttons which are 
located on the lower right corner of the monitoring pages.
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Shutdown Cylinder
The Shutdown Cylinder group box from the Monitoring page provides push and hold buttons that you can use to 
momentarily disable a cylinder while the engine is running.

To shutdown a cylinder
1. Read MPEM document from the vehicle.
2. Start the engine using the vehicle start/stop button.

3.

Click on the Monitoring page thumbnail.  Note that you may have to access the second
monitoring page using the navigation buttons located on the lower right corner of the
monitoring pages.

4. In the Shutdown Cylinder zone:

On a 2-cylinder engine, press and hold the MAG or PTO button.
On a 3-cylinder engine, press and hold the #1, #2 or #3 button.

5. Release button when you are finished.

Note
On some 2-cylinder engines, you can choose to disable only the fuel injection or both fuel injection and ignition.
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Oil Lines Bleeding
The Monitoring page provides a function that you can use to bleed the oil lines while the engine is running.
To bleed the oil lines
1. Read MPEM document from the vehicle.
2. Start the engine using the vehicle start/stop button.

3. Click on the Monitoring page thumbnail.
4. Click on the Oil Lines Bleeding button to force the engine to stay in idle speed.

5. Press and hold the vehicle throttle to wide open position for 45 seconds.
6. Press the message box OK button to terminate the operation.
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Activation Page
The Activation page provides functions that you can use to activate individual module outputs and to monitor module 
inputs when the engine is not running.  It also provides a self-test function that you can use to successively and 
automatically activate the outputs.

Activation functions are attached to standard push buttons and drawing hot spots while monitoring functions are 
attached to drawing hot spots only.

To activate an output
1. Read MPEM document from the vehicle.
2. Click on the Activation page thumbnail.
3. The content of the Activation page depends on the type of vehicle.

Personal watercraft equipped with a 947-DI engine
Personal watercraft equipped with a 1503 engine
Snowmobile equipped with a SDI engine
Snowmobile equipped with a V1004 engine

4. Click on the desired push button or hot spot.
5. Click on the message box Yes button to confirm your action.

Notes
Some vehicles have 2 activation pages.  The second page can be accessed using the navigation buttons which are 
located on the lower right corner of the activation pages.

Some activations require that you press and hold the button or the hot spot as long as you want the component to be 
activated.  Just release the button or the hot spot when you are finished.
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947-DI Activtion Page
Info center activation functions
The Info Center drawing contains two hot spots which are attached to the following activation functions:
Hot spot Activation function
Tachometer Display 3000 RPM on tachometer for 2.5 seconds.
Maintenance signal Turn on maintenance signal for 5 seconds.

Engine activation and monitoring functions
The Engine drawing contains red activation hot spots and blue monitoring hot spots which are attached to the 
following functions:
Hot spot Activation or monitoring function
MAG fuel injector Pulse MAG fuel injector as 3000 RPM during 500 ms.
PTO fuel injector Pulse PTO fuel injector as 3000 RPM during 500 ms.
MAG air injector Pulse MAG air injector as 3000 RPM during 500 ms.
PTO air injector Pulse PTO air injector as 3000 RPM during 500 ms.
MAG ignition coil Pulse MAG ignition coil as 3000 RPM during 500 ms.
PTO ignition coil Pulse PTO ignition coil as 3000 RPM during 500 ms.
MAG RAVE® solenoid Turn on RAVE solenoid for 1 second.
PTO RAVE® solenoid Turn on RAVE solenoid for 1 second.
MAG TPS Display the ADC value of MAG TPS in the status bar.
PTO TPS Display the ADC value of PTO TPS in the status bar.
Intake air pressure Display the intake air pressure in the status bar.
Intake air temperature Display the intake air temperature in the status bar.

Vehicle activation functions
The Activate group box contains push buttons which are attached to the following activation functions:
Button Activation function
Buzzer Activate the buzzer for 5 seconds.
Hi-Temp Signal Turn on info center high temperature signal for 5 seconds.
Fuel Pump Activate the fuel pump for 5 seconds.
Start Self-test Initiate a self-test.
Fuel Press. Relief Successively activate MAG air injector for 5 seconds and MAG fuel

injector for 15 seconds to relieve the fuel line pressure.
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1503 Activation Page
Engine activation and monitoring functions
The Engine drawing contains red activation hot spots and blue monitoring hot spots which are attached to the 
following functions:
Hot spot Activation or monitoring function
Fuel injector 1 Pulse fuel injector 1, 50 times in a row.
Fuel injector 2 Pulse fuel injector 2, 50 times in a row.
Fuel injector 3 Pulse fuel injector 3, 50 times in a row.
Ignition coil 1 Pulse ignition coil 1, 10 times in a row.
Ignition coil 2 Pulse ignition coil 2, 10 times in a row.
Ignition coil 3 Pulse ignition coil 3, 10 times in a row.
Blow by valve Activate blow by valve for 2 seconds.
Engine temperature Display the engine temperature in the status bar.
Intake air pressure Display the intake air pressure in the status bar.
Intake air temperature Display the intake air temperature in the status bar.
Exhaust temperature Display the exhaust temperature in the status bar (on some 

vehicles only).
Throttle opening Display the throttle opening angle in the status bar (on some 

vehicles only).

Vehicle activation functions
The Activation page shows the Fuel Pump group box which can be used to Enable or Disable the fuel pump.
Also shown is the Activate group box with push buttons which are attached to the following activation functions:
Button  Activation function
Fuel Press. Relief  Initiate the fuel pressure relief sequence which disables the 

fuel pump, then asks the user to start the engine and wait until 
it stops.  Clicking on the OK button re-enables the fuel pump.

Fuel Pump Activate the fuel pump for 5 seconds.
Buzzer Activate the buzzer until the button is released.
Bilge Pump Activate the bilge pump for 3 seconds.
VTS Initiate theVTS test sequence which successively moves the VTS 

fully up, fully down and then back to its original position.
Spare output 1 Turn on spare output 1 for 3 seconds.
Spare output 2 Turn on spare output 2 for 3 seconds (on some vehicles only).
Start Self-test Initiate a self-test.
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SDI Activation Page
Engine activation and monitoring functions
The Engine drawing contains red activation hot spots and blue monitoring hot spots which are attached to the 
following functions:
Hot spot Activation or monitoring function
Outer MAG fuel injector Pulse outer MAG fuel injector, 50 times in a row.
Inner MAG fuel injector Pulse inner MAG fuel injector, 50 times in a row.
Outer PTO fuel injector Pulse outer PTO fuel injector, 50 times in a row.
Inner PTO fuel injector Pulse inner PTO fuel injector, 50 times in a row.
MAG ignition coil Pulse MAG ignition coil, 10 times in a row.
PTO ignition coil Pulse PTO ignition coil, 10 times in a row.
RAVE® solenoid Activate RAVE solenoid until the button is released.
Engine temperature Display the engine temperature in the status bar.
Throttle opening Display the throttle opening angle in the status bar.

Vehicle activation functions
The Activation page shows the Fuel Pump group box which can be used to Enable or Disable the fuel pump.
Also shown is the Activate group box with push buttons which are attached to the following activation functions:
Button Activation function
Fuel Press. Relief Initiate the fuel pressure relief sequence which disables the fuel 

pump, then asks the user to start the engine and wait until it 
stops.  Clicking on the OK button re-enables the fuel pump.

Fuel Pump Activate the fuel pump for 5 seconds.
Buzzer Activate the buzzer until the button is released.
Relay 2 Turn on relay 2 until the button is released.
Relay 3 Turn on relay 3 until the button is released.
Start Self-test Initiate a self-test.

Gauges activation functions
The Gauges drawing contains hot spots which are attached to the following activation functions:
Hot spot Activation function
Engine warning LED Turn on engine warning LED until the hot spot is released.
Low oil pressure LED Turn on low oil pressure LED until the hot spot is released.
High temperature LED Turn on high temperature LED until the hot spot is released.
Battery voltage LED Turn on battery voltage LED until the hot spot is released.
DESS®/RER LED Turn on DESS/RER LED until the hot spot is released.
Tachometer Display 3000 RPM on tachometer until the hot spot is released.
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V1004 Activation Page
Engine activation and monitoring functions
The Engine drawing contains red activation hot spots and blue monitoring hot spots which are attached to the 
following functions:
Hot spot Activation or monitoring function
MAG fuel injector Pulse MAG fuel injector, 50 times in a row.
PTO fuel injector Pulse PTO fuel injector, 50 times in a row.
MAG ignition coil Pulse MAG ignition coil, 10 times in a row.
PTO ignition coil Pulse PTO ignition coil, 10 times in a row.
Engine temperature Display the engine temperature in the status bar.
Throttle opening Display the throttle opening angle in the status bar.
Intake air pressure Display the intake air pressure in the status bar.
Oil pressure switch Display the oil pressure switch status in the status bar.

Vehicle activation functions
The Activation page shows the Fuel Pump group box which can be used to Enable or Disable the fuel pump.
Also shown is the Activate group box with push buttons which are attached to the following activation functions:
Button Activation function
Fuel Press. Relief Initiate the fuel pressure relief sequence which disables the fuel 

pump, then asks the user to start the engine and wait until it 
stops.  Clicking on the OK button re-enables the fuel pump.

Fuel Pump Activate the fuel pump for 5 seconds.
Buzzer Activate the buzzer until the button is released.
Relay 2 Turn on relay 2 until the button is released.
Start Self-test Initiate a self-test.

Gauges activation functions
The Gauges drawing contains hot spots which are attached to the following activation functions:
Hot spot Activation function
Temperature gauge Display a high temperature value on gauge until the hot spot is 

released.
Engine warning LED Turn on engine warning LED until the hot spot is released.
High temperature LED Turn on high temperature LED until the hot spot is released.
DESS®/RER LED Turn on DESS/RER LED until the hot spot is released.
Tachometer Display 3000 RPM on tachometer until the hot spot is released.
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SELF TEST
The Activation page provides a function that you can use to successively and automatically activate the module 
outputs.  Even though the test is automatic, you may be asked to confirm individual activation.

To perform a self-test
1. Read MPEM document from the vehicle.
2. Click on the Activation page thumbnail.

3. Click on the Start Self-Test button.
4. Click on the message box Yes button to confirm your action.

5.
The sequence of the self-test depends on the type of
vehicle.
Personal watercraft equipped with a 947-DI engine
Personal watercraft equipped with a 1503 engine
Snowmobile equipped with a SDI engine
Snowmobile equipped with a V1004 engine
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947-DI Activation Self-test
The following outputs are successively activated during the self-test:

MAG and PTO ignition coils
MAG and PTO fuel injectors

MAG and PTO air injectors
RAVE® solenoid

Fuel pump
Buzzer
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1503 Activation Self-test
The following outputs are successively activated during the self-test:

Ignition coils 1, 2 and 3
Fuel injectors 1, 2 and 3
Blow by valve
Fuel pump
Buzzer
Bilge pump
VTS
Spare outputs 1 and 2  (on some vehicles, only one spare output is 
available)
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SDI Activation Self-test
The following outputs are successively activated during the self-test:

MAG and PTO ignition coils
Outer MAG and PTO fuel 
injectors
Inner MAG and PTO fuel 
injectors
Fuel pump
Buzzer
Relays 2 and 3
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V1004 Activation Self-test
The following outputs are successively activated during the self-test:

MAG and PTO ignition coils
MAG and PTO fuel 
injectors
Fuel pump
Buzzer
Relay 2
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Faults page 
The Faults page provides functions that you can use to read, clear and troubleshoot module faults.  All the faults 
available for a particular module are listed in the Summary table.
On most vehicles, the fault parameters are continuously and automatically updated at a rate of about two times per 
second.  On a RFI vehicle however, you must update the parameters manually by clicking on the Refresh button.
To open the Faults page
1. Read MPEM document from the vehicle.
2. Click on the Faults page thumbnail.

3.
The content of the Summary table depends on the type of
vehicle.
Personal watercraft equipped with a 947-DI engine
Personal watercraft equipped with a 1503 engine
Personal watercraft equipped with a RFI engine
Snowmobile equipped with a SDI or a V1004 engine

To get more details on a fault
1. Select a fault in the Summary table.
2. Click on the More Details... button.

3.
Click on the Close More Details button or any MPEM document page thumbnail when
you are finished.

Note
You can also get more details on a fault by double-clicking on the fault in the Summary table.
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947-DI Faults Page 
The Summary table displays 7 parameters for each fault.  Parameters are continuously and automatically updated at 
a rate of about two times per second.  The example below shows the parameters of a battery fault:
Code State Count First Clear Last  Description
P0563  Active          Battery voltage high

To clear a particular fault
1. Select the fault in the Summary table.
2. Click on the Clear Fault button.
3. Click on the message box Yes button.

4.
Wait until B.U.D.S. clears the fault into the
MPEM.

To clear all occurred faults
1. Click on the Clear Occurred Faults button.
2. Click on the message box Yes button.
3. Wait until B.U.D.S. clears all occurred faults into the MPEM.

Notes
Clearing a fault resets the Count and First time stamp to zero, increments the Clear counter by one and sets the 
Last time stamp to the current engine hours.  The status of the fault, which is controlled by the MPEM, remains the 
same.
If you clear the fault that has a double star (**) preceding the fault code, then the conditions associated to the fault 
in the More Details page are also cleared.
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1503, SDI and V1004 Faults Page 
The Summary table displays 7 parameters for each fault.  Parameters are continuously and automatically updated at 
a rate of about two times per second.  The example below shows the parameters for a battery fault:
Code State Module Count Cycle Time Total Time  Description
P0563 Active ECM  Battery voltage too high
To change the display of the summary table

From the drop down list, select the faults that you want to be displayed in the Summary table.  You can choose 
between:

All Faults
Active Faults
Active and Occured 
Faults

To clear a particular ECM fault
1. Select an ECM fault in the Summary table.
2. Click on the Clear Fault button.
3. Click on the message box Yes button.

4.
Wait until B.U.D.S. clears the fault into the
module.

5. Perform the ECM tracking procedure.

To clear all occurred faults
1. Click on the Clear Occurred Faults button.
2. Click on the message box Yes button.

3.
Wait until B.U.D.S. clears all occurred faults into
modules.

4. Perform the ECM tracking procedure.

Notes
You can not clear an individual MPEM fault with the Clear Fault button.
Clearing a fault resets the Count, Cycle and Total time stamps to zero.
If you clear a fault that has a double star (**) preceding the fault code, then the conditions associated to the fault in 
the More Details page are also cleared.
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RFI Faults Page 
The Summary table displays 3 parameters for each fault.  The example below shows the parameters of a battery 
fault:
Code  State  Description
P0563 (02 14 06)  Active  RFI engine module power-up voltage above upper 

limit

To refresh the faults parameters
On a RFI vehicle you are responsible for updating the faults parameters.  To do so, follow these steps:
1. Click on the Refresh button.
2. Wait until B.U.D.S. reads the faults parameters from the module.

To clear all occurred faults
1. Click on the Clear Occurred Faults button.
2. Click on the message box Yes button.
3. Wait until B.U.D.S. clears all occurred faults into the module.

Note
Clearing occurred faults resets the Status of all occurred faults to inactive.
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More Details Page
The More Details page provides information that you can use to know the possible causes of a fault and to 
determine what service actions should be done in order to fix the problem.
To open the More Details page
1. Read MPEM document from the vehicle.
2. Click on the Faults page thumbnail.
3. Select a fault in the Summary table.
4. Click on the More Details... button.

5.
The content of the More Details page depends on the type of
vehicle.

Personal watercraft equipped with a 947-DI engine
Personal watercraft equipped with a 1503 engine
Snowmobile equipped with a SDI or a V1004 engine

6.
Click on the Close More Details button or any MPEM document page thumbnail when 
you are finished.

Note
You can also get more details on a fault by double-clicking on the fault in the Summary table.
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947-DI More Details Page
First fault conditions
The following engine parameters are provided for the first fault that occurs after the conditions were reset:
Speed (RPM): The engine speed average.

TPS (%): The throttle opening in percent.

Intake (PSI): The intake air pressure.

Intake (°F): The intake air temperature.

Engine (°F): The engine temperature.

Exhaust (°F): The exhaust temperature.

Battery (V): The battery voltage.

To clear the first fault conditions

1.
Select the fault that has a double star (**) preceding the fault code in the Summary 
table.

2. Click on the More Details... button.
3. Click on the Clear Conditions button.
4. Click on the message box Yes button.
5. Wait until B.U.D.S. clears the first fault conditions.

To activate a faulty output
If the fault that is currently displayed in the More Details page concerns a module output, then you can activate it 
directly by pressing the Activate Component button.  If the fault does not concern a module output or if the engine 
is running, then the button is disabled.
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1503, SDI and V1004 More Details Page
Faults conditions
The following engine parameters are provided for all faults that are stored in the ECM and show the conditions that 
prevailed when the fault occured:
Speed (RPM): The engine speed.

TPS (%): The throttle opening in percent.

Intake (PSI): The intake air pressure.

Intake (°F): The intake air temperature.

Engine (°F): The engine temperature.

Exhaust (°F): The exhaust temperature.

Battery (V): The battery voltage.

Vehicle Speed (MPH): The vehicle speed (Set to zero when not available in the 
ECM).

Engine Status: The engine status when the fault occured.  Possible status 
are:

The engine was running with normal part load operating 
conditions.
The engine idle contact was closed.
The engine was running full load.
The engine idle contact was closed and fuel cut off was 
active.

Driving Cycles: The number of times the engine had started when the first 
occurrence of the fault appeared.

To clear fault conditions
To clear the conditions associated to a fault you must clear that fault.  To do so, follow these steps:

1.
Select a fault that has a double star (**) preceding the fault code in the Summary 
table.

2. Click on the Clear Fault button.
3. Click on the message box Yes button.
4. Wait until B.U.D.S. clears the fault and the fault conditions into the module.
5. Perform the ECM tracking procedure.

To activate a faulty output
If the fault that is currently displayed in the More Details page concerns a module output, then you can activate it 
directly by pressing the Activate Component button.  If the fault does not concern a module output or if the engine 
is running, then the button is disabled.
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P0001 - P0199
P0001 Fuel Volume Reg Ctrl Circ/Open
P0002 Fuel Volume Reg Ctrl Circ Range/Perf
P0003 Fuel Volume Reg Ctrl Circ Low
P0004 Fuel Volume Reg Ctrl Circ High
P0005 Fuel Shutoff Valve A Ctrl Circ/Open
P0006 Fuel Shutoff Valve A Ctrl Circ Low
P0007 Fuel Shutoff Valve A Ctrl Circ High
P0008 Engine Pos Sys Perf Bank1
P0009 Engine Pos Sys Perf Bank2
P0010 A Camshaft Pos Actuator Circ (bank) 
P0011 A Camshaft Pos Timing-Over-Advanced (bank)
P0012 A Camshaft Pos Timing-Over-Retarded (bank)
P0013 B Camshaft Pos Actuator Circ (bank
P0014 B Camshaft Pos Timing-Over-Advanced (bank)
P0015 B Camshaft Pos Timing-Over-Retarded (bank)
P0016 Crank Pos-Camshaft Pos Correlation Bank1 Sensor A
P0017 Crank Pos-Camshaft Pos Correlation Bank1 Sensor B
P0018 Crank Pos-Camshaft Pos Correlation Bank2 Sensor A
P0019 Crank Pos-Camshaft Pos Correlation Bank2 Sensor B 
P0020 A Camshaft Pos Actuator Circ (bank2)
P0021 A Camshaft Pos Timing-Over-Advanced (bank2)
P0022 A Camshaft Pos Timing-Over-Retarded (bank2)
P0023 B Camshaft Pos Actuator Circ (bank2)
P0024 B Camshaft Pos Timing-Over-Advanced (bank2)
P0025 B Camshaft Pos Timing-Over-Retarded (bank2)
P0026 Intake Valve Ctrl Solenoid Circ Range/Perf Bank1
P0027 Exhaust Valve Ctrl Solenoid Circ Range/Perf Bank1
P0028 Intake Valve Ctrl Solenoid Circ Range/Perf Bank2
P0029 Exhaust Valve Ctrl Solenoid Circ Range/Perf Bank2 
P0030 HO2S Heater Ctrl Circ (bank1, Sensor
P0031 HO2S Heater Ctrl Circ Lo (bank1, Sensor
P0032 HO2S Heater Ctrl Circ Hi (bank1, Sensor
P0033 Turbo Charger Bypass Valve Ctrl Circ
P0034 Turbo Charger Bypass Valve Ctrl Circ Lo
P0035 Turbo Charger Bypass Valve Ctrl Circ Hi
P0036 HO2S Heater Ctrl Circ (bank1, Sensor2)
P0037 HO2S Heater Ctrl Circ Lo (bank1, Sensor2)
P0038 HO2S Heater Ctrl Circ Hi (bank1, Sensor2)
P0039 T/S Charger Bypass Valve Ctrl Circ Range/Perf 
P0040 O2 Sensor Signals Swapped Bank1 Sensor 1/ Bank2 Sensor 1
P0041 O2 Sensor Signals Swapped Bank1 Sensor 2/ Bank2 Sensor 2
P0042 HO2S Heater Ctrl Circ (bank1, Sensor 3)
P0043 HO2S Heater Ctrl Circ Lo (bank1, Sensor 3)
P0044 HO2S Heater Ctrl Circ Hi (bank1, Sensor 3)
P0045 T/S Charger Boost Ctrl Solenoid Circ/Open
P0046 T/S Charger Boost Ctrl Solenoid Circ Range/Perf
P0047 T/S Charger Boost Ctrl Solenoid Circ Low
P0048 T/S Charger Boost Ctrl Solenoid Circ High
P0049 T/S Charger Turbine Overspeed 
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P0050 HO2S Heater Ctrl Circ (bank2, Sensor)
P0051 HO2S Heater Ctrl Circ Lo (bank2, Sensor)
P0052 HO2S Heater Ctrl Circ Hi (bank2, Sensor)
P0053 HO2S Heater Resistance Bank1 Sensor 1
P0054 HO2S Heater Resistance Bank1 Sensor 2
P0055 HO2S Heater Resistance Bank1 Sensor 3
P0056 HO2S Heater Ctrl Circ (bank2, Sensor2)
P0057 HO2S Heater Ctrl Circ Lo (bank2, Sensor2)
P0058 HO2S Heater Ctrl Circ Hi (bank2, Sensor2)
P0059 HO2S Heater Resistance Bank2 Sensor 1
P0060 HO2S Heater Resistance Bank2 Sensor 2
P0061 HO2S Heater Resistance Bank2 Sensor 3
P0062 HO2S Heater Ctrl Circ (bank2, Sensor 3)
P0063 HO2S Heater Ctrl Circ Lo (bank2, Sensor 3)
P0064 HO2S Heater Ctrl Circ Hi (bank2, Sensor 3)
P0065 Air Assisted Injector Ctrl Range/Perf
P0066 Air Assisted Injector Ctrl Circ/Circ Lo
P0067 Air Assisted Injector Ctrl Circ Hi
P0068 MAP/MAF-Throttle Pos Correlation
P0069 MAP-Barometric Press Correlation 
P0070 Ambient Air Temp Sensor Circ
P0071 Ambient Air Temp Sensor Range/Perf
P0072 Ambient Air Temp Sensor Circ Lo Input
P0073 Ambient Air Temp Sensor Circ Hi Input
P0074 Ambient Air Temp Sensor Circ Interm
P0075 Intake Valve Ctrl Circ (bank)
P0076 Intake Valve Ctrl Circ Lo (bank)
P0077 Intake Valve Ctrl Circ Hi (bank)
P0078 Exhaust Valve Ctrl Circ (bank)
P0079 Exhaust Valve Ctrl Circ Lo (bank) 
P0080 Exhaust Valve Ctrl Circ Hi (bank)
P0081 Intake Valve Ctrl Circ (bank2)
P0082 Intake Valve Ctrl Circ Lo (bank2)
P0083 Intake Valve Ctrl Circ Hi (bank2)
P0084 Exhaust Valve Ctrl Circ (bank2)
P0085 Exhaust Valve Ctrl Circ Lo (bank2)
P0086 Exhaust Valve Ctrl Circ Hi (bank2)
P0087 Fuel Rail/Sys Pres-Too Lo
P0088 Fuel Rail/Sys Pres-Too Hi
P0089 Fuel Pres Reg Perf 
P0090 Fuel Pres Reg Ctrl Circ
P0091 Fuel Pres Reg Ctrl Circ Lo
P0092 Fuel Pres Reg Ctrl Circ Hi
P0093 Fuel Sys Leak Detected-Large Leak
P0094 Fuel Sys Leak Detected-Small Leak
P0095 Intake Air Temp Sensor 2 Circ
P0096 Intake Air Temp Sensor 2 Circ Range/Perf
P0097 Intake Air Temp Sensor 2 Circ Low
P0098 Intake Air Temp Sensor 2 Circ High
P0099 Intake Air Temp Sensor 2 Circ Interm/Erratic 
P0100 Mass/Volume Air Flow Circ Error
P0101 Mass/Volume Air Flow Circ Range/Perf
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P0102 Mass/Volume Air Flow Circ Lo Input
P0103 Mass/Volume Air Flow Circ Hi Input
P0104 Mass/Volume Air Flow Circ Interm
P0105 MAP/Baro Pres Circ Error
P0106 MAP/Baro Pres Circ Range/Perf
P0107 MAP/Baro Pres Circ Lo Input
P0108 MAP/Baro Pres Circ Hi Input
P0109 MAP/Baro Pres Circ Interm 
P0110 Intake Air Temp Circ Error
P0111 Intake Air Temp Circ Range/Perf
P0112 Intake Air Temp Circ Lo Input
P0113 Intake Air Temp Circ Hi Input
P0114 Intake Air Temp Circ Interm
P0115 Eng Coolant Temp Circ Error
P0116 Eng Coolant Temp Circ Range/Perf
P0117 Eng Coolant Temp Circ Lo Input
P0118 Eng Coolant Temp Hi Input
P0119 Eng Coolant Temp Interm 
P0120 Throttle Pos Sensor/Switch A Circ Error
P0121 Throttle Pos Sensor/Switch A Circ Range/Perf
P0122 Throttle Pos Sensor/Switch A Circ Lo Input
P0123 Throttle Pos Sensor/Switch A Circ Hi Input
P0124 Throttle Pos Sensor/Switch A Circ Interm
P0125 Insuff Coolant Temp for Closed Loop Fuel Ctrl
P0126 Insuff Coolant Temp Stable Operation
P0127 Intake Air Temp Too Hi
P0128 Coolant Temp below Thermostat
P0129 Barometric Press Too Low 
P0130 Oxy Sensor Circ (bank1, Sensor)
P0131 Oxy Sensor Circ Lo Voltage (bank1, Sensor)
P0132 Oxy Sensor Circ Hi Voltage (bank1, Sensor)
P0133 Oxy Sensor Circ Slow Response (bank1, Sens)
P0134 Oxy Sens Circ No Activity Detected (bank1 Sens)
P0135 Oxy Sensor Heater Circ (bank1, Sensor)
P0136 Oxy Sensor Circ (bank1, Sensor2)
P0137 Oxy Sensor Circ Lo Voltage (bank1, Sensor2)
P0138 Oxy Sensor Circ Hi Voltage (bank1, Sensor2)
P0139 Oxy Sensor Circ Slow Response (bank1, Sensor2) 
P0140 Oxy Sens Circ No Activity Detected (bank1 Sens2)
P0141 Oxy Sensor Heater Circ (bank1, Sensor2)
P0142 Oxy Sensor Circ (bank1, Sensor 3)
P0143 Oxy Sensor Circ Lo Voltage (bank1, Sensor 3)
P0144 Oxy Sensor Circ Hi Voltage (bank1, Sensor 3)
P0145 Oxy Sensor Circ Slow Response (bank1, Sensor 3)
P0146 Oxy Sensor Circ No Activity Detected (bank1 Sens3)
P0147 Oxy Sensor Heater Circ (bank1, Sensor 3)
P0148 Fuel Delivery Error
P0149 Fuel Timing Error 
P0150 Oxy Sensor Circ (bank2, Sensor
P0151 Oxy Sensor Circ Lo Voltage (bank2, Sensor)
P0152 Oxy Sensor Circ Hi Voltage (bank2, Sensor)
P0153 Oxy Sensor Circ Slow Response (bank2, Sensor)
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P0154 Oxy Sensor Circ No Activity Detected (bank2 Sensor)
P0155 Heated Oxy Sensor Heater Circ (bank2, Sensor
P0156 Oxy Sensor Circ (bank2, Sensor2)
P0157 Oxy Sensor Circ Lo Voltage (bank2, Sensor2)
P0158 Oxy Sensor Circ Hi Voltage (bank2, Sensor2)
P0159 Oxy Sensor Circ Slow Response (bank2, Sensor2) 
P0160 Oxy Sensor Circ No Activity Detected (bank2 Sens2)
P0161 Heated Oxy Sensor Heater Circ (bank2, Sensor2)
P0162 Oxy Sensor Circ (bank2, Sensor 3)
P0163 Oxy Sensor Circ Lo Voltage (bank2, Sensor 3)
P0164 Oxy Sensor Circ Hi Voltage (bank2, Sensor 3)
P0165 Oxy Sensor Circ Slow Response (bank2, Sensor 3)
P0166 Oxy Sensor Circ No Activity Detected (bank2 Sens3)
P0167 Heated Oxy Sensor Heater Circ (bank2, Sensor 3)
P0168 Eng Fuel Temp Hi
P0169 Incorrect Fuel ComPos
P0170 Fuel Trim Error (bank)
P0171 Sys too Lean (bank)
P0172 Sys too Rich (bank)
P0173 Fuel Trim Error (bank2)
P0174 Sys too Lean (bank2)
P0175 Sys too Rich (bank2)
P0176 Fuel ComPos Sensor Circ Error
P0177 Fuel ComPos Sensor Circ Range/Perf
P0178 Fuel ComPos Sensor Circ Lo Input
P0179 Fuel ComPos Sensor Circ Hi Input
P0180 Fuel Temp SensorA Circ Error
P0181 Fuel Temp SensorA Circ Range/Perf
P0182 Fuel Temp SensorA Circ Lo Input
P0183 Fuel Temp SensorA Circ Hi Input
P0184 Fuel Temp SensorA Circ Interm
P0185 Fuel Temp SensorB Circ Error
P0186 Fuel Temp SensorB Circ Range/Perf
P0187 Fuel Temp SensorB Circ Lo Input
P0188 Fuel Temp SensorB Circ Hi Input
P0189 Fuel Temp SensorB Circ Interm
P0190 Fuel Rail Pres Sensor Circ Error
P0191 Fuel Rail Pres Sensor Circ Range/Perf
P0192 Fuel Rail Pres Sensor Circ Lo Input
P0193 Fuel Rail Pres Sensor Circ Hi Input
P0194 Fuel Rail Pres Sensor Circ Interm
P0195 Eng Oil Temp Sensor Error
P0196 Eng Oil Temp Sensor Range/Perf
P0197 Eng Oil Temp Sensor Circ Lo Input
P0198 Eng Oil Temp Sensor Circ Hi Input
P0199 Eng Oil Temp Sensor Interm
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P0200 - P0399
P0200 Injector Circ Error
P0201 Injector Circ Error-Cyl1
P0202 Injector Circ Error-Cyl2
P0203 Injector Circ Error-Cyl3
P0204 Injector Circ Error-Cyl4
P0205 Injector Circ Error-Cyl5
P0206 Injector Circ Error-Cyl6
P0207 Injector Circ Error-Cyl7
P0208 Injector Circ Error-Cyl8
P0209 Injector Circ Error-Cyl9
P0210 Injector Circ Error-Cyl10 
P0211 Injector Circ Error-Cyl11
P0212 Injector Circ Error-Cyl12
P0213 Cold Start Injector 1 Error
P0214 Cold Start Injector 2 Error
P0215 Eng Shutoff Solenoid Error
P0216 Inj Timing Ctrl Circ Error
P0217 Eng Over temp Condition
P0218 Tran Over temp Condition
P0219 Throttle Sw B Circ Error/Eng Over speed Condition
P0220 Throttle Pos Sensor/Switch B Circ Error 
P0221 Throttle Pos Sensor/Switch B Circ Range/Perf
P0222 Throttle Pos Sensor/Switch B Circ Lo Input
P0223 Throttle Pos Sensor/Switch B Circ Hi Input
P0224 Throttle Pos Sensor/Switch B Circ Interm
P0225 Throttle Pos Sensor/Switch C Circ Error
P0226 Throttle Pos Sensor/Switch C Circ Range/Perf
P0227 Throttle Pos Sensor/Switch C Circ Lo Input
P0228 Throttle Pos Sensor/Switch C Circ Hi Input
P0229 Throttle Pos Sensor/Switch C Circ Interm
P0230 Fuel Pump Relay Dvr Fail 
P0231 Fuel Pump Relay Dvr Circ Fail On
P0232 Fuel Pump Relay Dvr Circ Fail Off
P0233 Fuel Pump Relay Dvr Interm
P0234 Eng Over boost Condition
P0235 Turbo Boost SensorA Circ Error
P0236 Turbo Boost SensorA Circ Perf
P0237 Turbo Boost SensorA Circ Lo Input
P0238 Turbo Boost SensorA Circ Hi Input
P0239 Turbo Boost SensorB Circ Error
P0240 Turbo Boost SensorB Circ Perf 
P0241 Turbo Boost SensorB Circ Lo Input
P0242 Turbo Boost SensorB Circ Hi Input
P0243 Turbo Wastegate Solenoid A Error
P0244 Turbo Wastegate Solenoid A Range/Perf
P0246 Turbo Wastegate Solenoid A Hi
P0247 Turbo Wastegate Solenoid A Error
P0248 Turbo Wastegate Solenoid A Range/Perf
P0249 Turbo Wastegate Solenoid A Lo
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P0250 Turbo Wastegate Solenoid A Hi 
P0251 Inj Pump Fuel Metering Ctrl A Error
P0252 Inj Pump Fuel Metering Ctrl A Range/Perf
P0253 Inj Pump Fuel Metering Ctrl A Lo
P0254 Inj Pump Fuel Metering Ctrl A Hi
P0255 Inj Pump Fuel Metering Ctrl A Interm
P0256 Inj Pump Fuel Metering Ctrl A Error
P0257 Inj Pump Fuel Metering Ctrl A Range/Perf
P0258 Inj Pump Fuel Metering Ctrl A Lo
P0259 Inj Pump Fuel Metering Ctrl A Hi
P0260 Inj Pump Fuel Metering Ctrl A Interm 
P0261 Injector Circ Lo-Cyl1c
P0262 Injector Circ Hi-Cyl1
P0263 Cyl1 Contribution/Balance Fault
P0264 Injector Circ Lo-Cyl2
P0265 Injector Circ Hi-Cyl2
P0266 Cyl2 Contribution/Balance Fault
P0267 Injector Circ Lo-Cyl3
P0268 Injector Circ Hi-Cyl3
P0269 Cyl3 Contribution/Balance Fault
P0270 Injector Circ Lo-Cyl4 
P0271 Injector Circ Hi-Cyl4
P0272 Cyl4 Contribution/Balance Fault
P0273 Injector Circ Lo-Cyl5
P0274 Injector Circ Hi-Cyl5
P0275 Cyl5 Contribution/Balance Fault
P0276 Injector Circ Lo-Cyl6
P0277 Injector Circ Hi-Cyl6
P0278 Cyl6 Contribution/Balance Fault
P0279 Injector Circ Lo-Cyl7
P0280 Injector Circ Hi-Cyl7 
P0281 Cyl7 Contribution/Balance Fault
P0282 Injector Circ Lo-Cyl8
P0283 Injector Circ Hi-Cyl8
P0284 Cyl8 Contribution/Balance Fault
P0285 Injector Circ Lo-Cyl9
P0286 Injector Circ Hi-Cyl9
P0287 Cyl9 Contribution/Balance Fault
P0288 Injector Circ Lo-Cyl10
P0289 Injector Circ Hi-Cyl10
P0290 Cyl10 Contribution/Balance Fault 
P0291 Injector Circ Lo-Cyl11
P0292 Injector Circ Hi-Cyl11
P0293 Cyl11 Contribution/Balance Fault
P0294 Injector Circ Lo-Cyl12
P0295 Injector Circ Hi-Cyl12
P0296 Cyl12 Contribution/Balance Fault
P0297 Vehicle Overspeed Condition
P0298 Eng Oil Over temp Condition
P0299 T/S Charger Underboost
P0300 Random/Multiple Cylinder Misfire Detected 
P0301 Fault Cylinder A-Misfire Detected (CYL)
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P0302 Fault Cylinder B-Misfire Detected (CYL2)
P0303 Fault Cylinder D-Misfire Detected (CYL3)
P0304 Fault Cylinder E-Misfire Detected (CYL4)
P0305 Fault Cylinder F-Misfire Detected (CYL5)
P0306 Fault Cylinder G-Misfire Detected (CYL6)
P0307 Fault Cylinder C-Misfire Detected (CYL7)
P0308 Fault Cylinder H-Misfire Detected (CYL8)
P0309 Fault Cylinder I-Misfire Detected (CYL9)
P0310 Fault Cylinder J-Misfire Detected (CYL10) 
P0311 Fault Cylinder K-Misfire Detected (CYL1)
P0312 Fault Cylinder L-Misfire Detected (CYL12)
P0313 Misfire Detected with Lo Fuel
P0314 1 Cylinder Misfire (Cylinder not specific)
P0315 Crank Pos Sys Variation Not Learned
P0316 Engine Misfire Detected on Startup (First 1000 Revs)
P0317 Rough Road Hardware Not Present
P0318 Rough Road SensorA Signal Circ
P0319 Rough Road SensorB
P0320 Ign/Distributor Eng Speed Input Circ Error 
P0321 Ign/Distributor Eng Speed Input Circ Range/Perf
P0322 Ign/Distributor Eng Speed Input Circ No Signal
P0323 Ign/Distributor Eng Speed Input Circ Interm
P0324 Knock Ctrl Sys Error
P0325 Knock Sensor1 Circ Error (bank1/1 Sensor)
P0326 Knock Sensor1 Circ Range/Perf (bank1/1 Sensor)
P0327 Knock Sensor1 Circ Lo Input (bank1/1 Sensor)
P0328 Knock Sensor1 Circ Hi Input (bank1/1 Sensor)
P0329 Knock Sensor1 Circ Interm (bank1/1 Sensor)
P0330 Knock Sensor2 Circ Error (bank2) 
P0331 Knock Sensor2 Circ Range/Perf (bank2)
P0332 Knock Sensor2 Circ Lo Input (bank2)
P0333 Knock Sensor2 Circ Hi Input (bank2)
P0334 Knock Sensor2 Circ Interm (bank2)
P0335 Crank Pos SensorA Circ Error
P0336 Crank Pos SensorA Circ Range/Perf
P0337 Crank Pos SensorA Circ Lo Input
P0338 Crank Pos SensorA Circ Hi Input
P0339 Crank Pos SensorA Circ Interm
P0340 Camshaft Pos Sensor Circ Error (bank1/1 Sensor) 
P0341 Camshaft Pos Sensor Circ Perf (bank1/1 Sensor)
P0342 Camshaft Pos Sensor Circ Lo Input (bank1/1 Sensor)
P0343 Camshaft Pos Sensor Circ Hi Input (bank1/1 Sensor)
P0344 Camshaft Pos Sensor Circ Interm (bank1/1 Sens)
P0345 Camshaft Pos Sensor Circ Error (bank2)
P0346 Camshaft Pos Sensor Circ Perf (bank2)
P0347 Camshaft Pos Sensor Circ Lo Input (bank2)
P0348 Camshaft Pos Sensor Circ Hi Input (bank2)
P0349 Camshaft Pos Sensor Circ Interm (bank2)
P0350 Ignition Coil Pri/Sec Circ Error 
P0351 Ignition Coil A Pri/Sec Circ Error
P0352 Ignition Coil B Pri/Sec Circ Error
P0353 Ignition Coil C Pri/Sec Circ Error
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P0354 Ignition Coil D Pri/Sec Circ Error
P0355 Ignition Coil E Pri/Sec Circ Error
P0356 Ignition Coil F Pri/Sec Circ Error
P0357 Ignition Coil G Pri/Sec Circ Error
P0358 Ignition Coil H Pri/Sec Circ Error
P0359 Ignition Coil I Pri/Sec Circ Error
P0360 Ignition Coil J Pri/Sec Circ (Glow Plug) Error 
P0361 Ignition Coil K Pri/Sec Circ (Glow Plug Indicator) Error
P0362 Ignition Coil L Pri/Sec Circ Error
P0363 Misfire Detected-Fueling Disabled
P0364 Reserved
P0365 Crank Pos SensorB Circ Error (bank)
P0366 Crank Pos SensorB Circ Range/Perf (bank)
P0367 Crank Pos SensorB Circ Lo Input (bank)
P0368 Crank Pos SensorB Circ Hi Input (bank)
P0369 Crank Pos SensorB Circ Interm (bank)
P0370 Timing Ref Hi Res Signal A Error 
P0371 Timing Ref Hi Res Signal A Too Many Pulses
P0372 Timing Ref Hi Res Signal A Too Few Pulses
P0373 Timing Ref Hi Res Signal A Interm/Erratic Pulses
P0374 Timing Ref Hi Res Signal A No Pulses
P0375 Timing Ref Hi Res Signal B Error
P0376 Timing Ref Hi Res Signal B Too Many Pulses
P0377 Timing Ref Hi Res Signal B Too Few Pulses
P0378 Timing Ref Hi Res Signal B Interm/Erratic Pulses
P0379 Timing Ref Hi Res Signal B No Pulses
P0380 Glow Plug Circ Error Circ A 
P0381 Glow Plug Indicator Circ Error
P0382 Glow Plug Circ Error Circ B
P0383 P0384 Reserved by document
P0385 Crank Pos SensorB Circ Error
P0386 Crank Pos SensorB Circ Range/Perf
P0387 Crank Pos SensorB Circ Lo Input
P0388 Crank Pos SensorB Circ Hi Input
P0389 Crank Pos SensorB Circ Interm
P0390 Crank Pos SensorB Circ Error (bank2) 
P0391 Crank Pos SensorB Circ Range/Perf (bank2)
P0392 Crank Pos SensorB Circ Lo Input (bank2)
P0393 Crank Pos SensorB Circ Hi Input (bank2)
P0394 Crank Pos SensorB Circ Interm (bank2)
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P0400 - P0599
P0400 Exhaust Gas Recirculation Flow Error
P0401 Exhaust Gas Recirculation Flow Insuff Detected
P0402 Exhaust Gas Recirculation Flow Excessive Detected
P0403 Exhaust Gas Recirculation Circ Error
P0404 Exhaust Gas Recirculation Circ Range/Perf
P0405 Exhaust Gas Recirculation SensorA Circ Lo
P0406 Exhaust Gas Recirculation SensorA Circ Hi
P0407 Exhaust Gas Recirculation SensorB Circ Lo
P0408 Exhaust Gas Recirculation SensorB Circ Hi
P0409 Exhaust Gas Recirculation SensorA Circ
P0410 Sec Air Inj Sys Error 
P0411 Sec Air Inj Sys Incorrect Flow Detected
P0412 Sec Air Inj Sys Switching Valve A Circ Error
P0413 Sec Air Inj Sys Switching Valve A Circ Open
P0414 Sec Air Inj Sys Switching Valve A Circ Shorted
P0415 Sec Air Inj Sys Switching Valve B Circ Error
P0416 Sec Air Inj Sys Switching Valve B Circ Open
P0417 Sec Air Inj Sys Switching Valve B Circ Shorted
P0418 Sec Air Inj Sys Relay A Circ Error
P0419 Sec Air Inj Sys Relay B Circ Error
P0420 Catalyst Sys Efficiency below Threshold (bank) 
P0421 Warm Up Catalyst Efficiency below Thresh (bank)
P0422 Main Catalyst Efficiency below Threshold (bank)
P0423 Heated Catalyst Efficiency below Threshold (bank)
P0424 Heated Catalyst Temp below Threshold (bank)
P0425 Catalyst Temp Sensor (bank)
P0426 Catalyst Temp Sensor Range/Perf (bank)
P0427 Catalyst Temp Sensor Lo Input (bank)
P0428 Catalyst Temp Sensor Hi Input (bank0
P0429 Catalyst Heater Ctrl Circ (bank)
P0430 Catalyst Sys Efficiency below Threshold (bank2) 
P0431 Warm Up Catalyst Efficiency below Thresh (bank2)
P0432 Main Catalyst Efficiency below Threshold (bank2)
P0433 Heated Catalyst Efficiency below Threshold (bank2)
P0434 Heated Catalyst Temp below Threshold (bank2)
P0435 Catalyst Temp Sensor (bank2)
P0436 Catalyst Temp Sensor Range/Perf (bank2)
P0437 Catalyst Temp Sensor Lo Input (bank2)
P0438 Catalyst Temp Sensor Hi Input (bank2)
P0439 Catalyst Heater Ctrl Circ (bank2)
P0440? Evap Emission Ctrl Sys Error 
P0441? Evap Emission Ctrl Sys Incorrect Purge Flow
P0442? Evap Emission Ctrl Sys Leak Detected (small leak)
P0443? Evap Emission Ctrl Sys Purge Ctrl Valve Circ Error
P0444 Evap Emission Ctrl Sys Purge Ctrl Valve Circ Open
P0445 Evap Emission Ctrl Sys Purge Ctrl Valve Circ Shorted
P0446 Evap Emission Ctrl Sys Vent Ctrl Circ Error
P0447 Evap Emission Ctrl Sys Vent Ctrl Circ Open
P0448 Evap Emission Ctrl Sys Vent Ctrl Circ Shorted
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P0449 Evap Emission Ctrl Sys Vent Valve/Solenoid Circ Error
P0450 Evap Emission Ctrl Sys Pres Sensor Error 
P0451 Evap Emission Ctrl Sys Pres Sensor Range/Perf
P0452 Evap Emission Ctrl Sys Pres Sensor Lo Input
P0453 Evap Emission Ctrl Sys Pres Sensor Hi Input
P0454 Evap Emission Ctrl Sys Pres Sensor Interm
P0455 Evap Emission Ctrl Sys Gross Leak Detected
P0456 Evap Emission Ctrl Sys Very Small Leak Detected)
P0457 Evap Emission Ctrl Sys Leak (fuel cap loose/off)
P0458 Evaporative Emission Sys Purge Ctrl Valve Circ Low
P0459 Evaporative Emission Sys Purge Ctrl Valve Circ High
P0460 Fuel Tank Level Indicator Circ Error 
P0461 Fuel Level Sensor Circ Range/Perf
P0462 Fuel Level Sensor Circ Lo Input
P0463 Fuel Level Sensor Circ Hi Input
P0464 Fuel Level Sensor Circ Interm
P0465 EVAP Purge Flow Sensor Circ
P0466 EVAP Purge Flow Sensor Circ Range/Perf
P0467 EVAP Purge Flow Sensor Circ Lo Input
P0468 EVAP Purge Flow Sensor Circ Hi Input
P0469 EVAP Purge Flow Sensor Circ Interm
P0470 Exhaust Back Pres Sensor Circ Error 
P0471 Exhaust Back Pres Sensor Circ Perf
P0472 Exhaust Back Pres Sensor Circ Lo Input
P0473 Exhaust Back Pres Sensor Circ Hi Input
P0474 Exhaust Back Pres Sensor Interm
P0475 Exhaust Pres Ctrl Valve Error
P0476 Exhaust Pres Ctrl Valve Range/Perf
P0477 Exhaust Pres Ctrl Valve Lo Output
P0478 Exhaust Pres Ctrl Valve Hi Input
P0479 Exhaust Pres Ctrl Valve Interm
P0480 Cooling Fan 1 Ctrl Circ Error 
P0481 Cooling Fan 2 Ctrl Circ Error
P0482 Cooling Fan 3 Ctrl Circ Error
P0483 Cooling Fan Rationality Check Error
P0484 Cooling Fan Circ over Current
P0485 Cooling Fan Power/Ground Circ Error
P0486 EGR SensorB Circ
P0487 EGR Throttle Pos Ctrl Circ
P0488 EGR Throttle Pos Ctrl Range/Perf
P0489 Exhaust Gas Recirculation Ctrl Circ Low
P0490 Exhaust Gas Recirculation Ctrl Circ High 
P0491 Sec Air Inj Sys (bank)
P0492 Sec Air Inj Sys (bank2)
P0493 Fan Overspeed
P0494 Fan Speed Low
P0495 Fan Speed High
P0496 Evaporative Emission Sys High Purge Flow
P0497 Evaporative Emission Sys Low Purge Flow
P0500 Vehicle Speed Sensor (VSS) Error 
P0501 Vehicle Speed Sensor Range/Perf
P0502 Vehicle Speed Sensor Lo Input
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P0503 Vehicle Speed Sensor Noisy
P0504 Brake Switch A/B Correlation
P0505 Idle Ctrl Sys Error
P0506 Idle Ctrl Sys RPM Lower Than Expected
P0507 Idle Ctrl Sys RPM Higher Than Expected
P0508 Idle Ctrl Sys Circ Lo
P0509 Idle Ctrl Sys Circ Hi
P0510 Closed Throttle Pos Switch Error 
P0511 Idle Air Ctrl Circ
P0512 Starter Request Circ
P0513 Incorrect Immobilizer Key
P0514 Battery Temp Sensor Circ Range/Perf
P0515 Battery Temp Sensor Circ
P0516 Battery Temp Sensor Circ Lo
P0517 Battery Temp Sensor Circ Hi
P0518 Idle Air Ctrl Circ Interm
P0519 Idle Air Ctrl Sys Perf
P0520 Eng Oil Pres Sensor/Switch Circ Error 
P0521 Eng Oil Pres Sensor/Switch Circ Range/Perf
P0522 Eng Oil Pres Sensor/Switch Circ Lo Voltage
P0523 Eng Oil Pres Sensor/Switch Circ Hi Voltage
P0524 Eng Oil Pres Too Lo
P0525 Cruise Ctrl Servo Ctrl Circ Range/Perf
P0526 Fan Speed Sensor Circ
P0527 Fan Speed Sensor Circ Range/Perf
P0528 Fan Speed Sensor Circ No Signal
P0529 Fan Speed Sensor Circ Interm
P0530 A/C Refrigerant Pres Sensor Circ Error 
P0531 A/C Refrigerant Pres Sensor Circ Range/Perf
P0532 A/C Refrigerant Pres Sensor Circ Lo Input
P0533 A/C Refrigerant Pres Sensor Circ Hi Input
P0534 Air Conditioner Refrigerant Charge Loss
P0535 A/C Evaporator Temp Sensor Circ
P0536 A/C Evaporator Temp Sensor Circ Range/Perf
P0537 A/C Evaporator Temp Sensor Circ Low
P0538 A/C Evaporator Temp Sensor Circ High
P0539 A/C Evaporator Temp Sensor Circ Interm
P0540 Manifold Intake Air Heater Circ 
P0541 Manifold Intake Air Heater Circ Lo
P0542 Manifold Intake Air Heater Circ Hi
P0543 Intake Air Heater A Circ Open
P0544 EGT Sensor Circ bank1
P0545 EGT Sensor Circ Lo bank1
P0546 EGT Sensor Circ Hi bank1
P0547 EGT Sensor Circ bank2
P0548 EGT Sensor Circ Lo bank2
P0549 EGT Sensor Circ Hi bank2
P0550 Power Steering Pres Sensor Circ Error 
P0551 Power Steering Pres Sensor Circ Range/Perf
P0552 Power Steering Pres Sensor Circ Lo Input
P0553 Power Steering Pres Sensor Circ Hi Input
P0554 Power Steering Pres Sensor Circ Interm
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P0555 Brake Booster Press Sensor Circ
P0556 Brake Booster Press Sensor Circ Range/Perf
P0557 Brake Booster Press Sensor Circ Low Input
P0558 Brake Booster Press Sensor Circ High Input
P0559 Brake Booster Press Sensor Circ Interm
P0560 Sys Voltage Error 
P0561 Sys Voltage Unstable
P0562 Sys Voltage Lo
P0563 Sys Voltage Hi
P0564 Cruise Ctrl Multi-Func Input Signal
P0565 Cruise Ctrl ON Signal Error
P0566 Cruise Ctrl OFF Signal Error
P0567 Cruise Ctrl RESUME Signal Error
P0568 Cruise Ctrl SET Signal Error
P0569 Cruise Ctrl COAST Signal Error
P0570 Cruise Ctrl ACCEL Signal Error
P0571 Cruise Ctrl/Brake Switch A Circ Fail
P0572 Cruise Ctrl/Brake Switch A Circ Lo
P0573 Cruise Ctrl/Brake Switch A Circ Hi
P0574 Cruise Ctrl Sys Vehicle Speed Too Hi
P0575 Cruise Ctrl Input Circ
P0576 Cruise Ctrl Input Circ Lo
P0577 Cruise Ctrl Input Circ Hi
P0578 Cruise Ctrl Multi-Func Input A Circ Stuck
P0579 Cruise Ctrl Multi-Func Input A Circ Range/Perf
P0580 Cruise Ctrl Multi-Func Input A Circ Low 
P0581 Cruise Ctrl Multi-Func Input A Circ High
P0582 Cruise Ctrl Vacuum Ctrl Circ/Open
P0583 Cruise Ctrl Vacuum Ctrl Circ Low
P0584 Cruise Ctrl Vacuum Ctrl Circ High
P0585 Cruise Ctrl Multi-Func Input A/B Correlation
P0586 Cruise Ctrl Vent Ctrl Circ/Open
P0587 Cruise Ctrl Vent Ctrl Circ Low
P0588 Cruise Ctrl Vent Ctrl Circ High
P0589 Cruise Ctrl Multi-Func Input B Circ
P0590 Cruise Ctrl Multi-Func Input B Circ Stuck 
P0591 Cruise Ctrl Multi-Func Input B Circ Range/Perf
P0592 Cruise Ctrl Multi-Func Input B Circ Low
P0593 Cruise Ctrl Multi-Func Input B Circ High
P0594 Cruise Ctrl Servo Ctrl Circ/Open
P0595 Cruise Ctrl Servo Ctrl Circ Low
P0596 Cruise Ctrl Servo Ctrl Circ High
P0597 Thermostat Heater Ctrl Circ/Open
P0598 Thermostat Heater Ctrl Circ Low
P0599 Thermostat Heater Ctrl Circ High
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P0600 - P0799
P0600 Serial Comms Link Error
P0601 Internal Ctrl Mod Memory Check Sum Error
P0602 Ctrl Mod Programming Error
P0603 Internal Ctrl Mod KAM Error
P0604 Internal Ctrl Mod RAM Error
P0605 Internal Ctrl Mod ROM Error
P0606 PCM Processor Fault
P0607 Powertrain Ctrl Mod Perf
P0608 Powertrain Ctrl Mod VSS Output A Error
P0609 Powertrain Ctrl Mod VSS Output B Error
P0610 Powertrain Ctrl Mod Vehicle Options Error 
P0611 Fuel Injector Ctrl Mod Perf
P0612 Fuel Injector Ctrl Mod Ctrl Circ
P0613 TCM Processor
P0614 ECM / TCM Incompatible
P0615 Starter Relay Circ
P0616 Starter Relay Circ Lo
P0617 Starter Relay Circ Hi
P0618 Alternative Fuel Ctrl Mod KAM Error
P0619 Alternative Fuel Ctrl Mod RAM/ROM Error
P0620 Generator Ctrl Circ Error 
P0621 Generator Lamp L Ctrl Circ Error
P0622 Generator Field F Ctrl Circ Error
P0623 Generator Lamp Ctrl Circ Error
P0624 Fuel Cap Lamp Ctrl Circ Error
P0625 Generator Field/F Terminal Circ Low
P0626 Generator Field/F Terminal Circ High
P0627 Fuel Pump A Ctrl Circ /Open
P0628 Fuel Pump A Ctrl Circ Low
P0629 Fuel Pump A Ctrl Circ High
P0630 VIN Not Programmed/Mismatch-ECM/PCM 
P0631 VIN Not Programmed/Mismatch-TCM
P0632 Odometer Not Programmed-ECM/PCM
P0633 Immobilizer Key Not Programmed-ECM/PCM
P0634 PCM/ECM/TCM Internal Temp Too High
P0635 Power Steering Ctrl Circ
P0636 Power Steering Ctrl Circ Lo
P0637 Power Steering Ctrl Circ Hi
P0638 Throttle Actuator Ctrl Range/Perf bank1
P0639 Throttle Actuator Ctrl Range/Perf bank2
P0640 Manifold Intake Air Heater Ctrl Circ 
P0641 Sensor Ref Voltage A Circ/Open
P0642 Sensor Ref Voltage A Circ Low
P0643 Sensor Ref Voltage A Circ High
P0644 Driver Display Serial Comm Circ
P0645 A/C Clutch Relay Ctrl Circ
P0646 A/C Clutch Relay Ctrl Circ Lo
P0647 A/C Clutch Relay Ctrl Circ Hi
P0648 Immobilizer Lamp Ctrl Circ
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P0649 Cruise Ctrl Lamp Ctrl Circ
P0650 Error Indicator Lamp (MIL) Ctrl Circ Error 
P0651 Sensor Ref Voltage B Circ/Open
P0652 Sensor Ref Voltage B Circ Low
P0653 Sensor Ref Voltage B Circ High
P0654 Eng RPM Output Circ Error
P0655 Eng Hot Lamp Output Ctrl Circ MalFunc
P0656 Fuel Level Output Circ Error
P0657 Actuator Supply Voltage A Circ/Open
P0658 Actuator Supply Voltage A Circ Low
P0659 Actuator Supply Voltage A Circ High
P0660 Intake Manif Tuning Valve Ctrl Circ bank1 
P0661 Intake Manif Tuning Valve Ctrl Circ Lo bank1
P0662 Intake Manif Tuning Valve Ctrl Circ Hi bank1
P0663 Intake Manif Tuning Valve Ctrl Circ bank2
P0664 Intake Manif Tuning Valve Ctrl Circ Lo bank2
P0665 Intake Manif Tuning Valve Ctrl Circ Hi bank2
P0666 Cruise 'On Signal Error
P0667 Cruise 'Resume' Signal Error
P0668 Cruise Set' Signal Error
P0669 Cruise Coast' Signal Error
P0670 Glow plug Ctrl Circ Error 
P0671 Glow plug #1 Circ failure
P0672 Glow plug #2 Circ failure
P0673 Glow plug #3 Circ failure
P0674 Glow plug #4 Circ failure
P0675 Glow plug #5 Circ failure
P0676 Glow plug #6 Circ failure
P0677 Glow plug #7 Circ failure
P0678 Glow plug #8 Circ failure
P0679 Reserve for future Glow plug #9
P0680 Reserve for future Glow plug #10 
P0681 Reserve for future Glow plug #11
P0682 Reserve for future Glow plug #12
P0683 Glow Plug Ctrl Mod to PCM Comm Circ
P0684 Glow Plug Ctrl Mod to PCM Comm Circ
Range/Perf
P0685 ECM/PCM Power Relay Ctrl Circ /Open
P0686 ECM/PCM Power Relay Ctrl Circ Low
P0687 ECM/PCM Power Relay Ctrl Circ High
P0688 ECM/PCM Power Relay Sense Circ /Open
P0689 ECM/PCM Power Relay Sense Circ Low
P0690 ECM/PCM Power Relay Sense Circ High 
P0691 Fan 1 Ctrl Circ Low
P0692 Fan 1 Ctrl Circ High
P0693 Fan 2 Ctrl Circ Low
P0694 Fan 2 Ctrl Circ High
P0695 Fan 3 Ctrl Circ Low
P0696 Fan 3 Ctrl Circ High
P0697 Sensor Ref Voltage C Circ/Open
P0698 Sensor Ref Voltage C Circ Low
P0699 Sensor Ref Voltage C Circ High
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P0700 Tran Ctrl Sys Error 
P0701 Tran Ctrl Sys Range/Perf
P0702 Tran Ctrl Sys Electrical
P0703 Brake Switch B Circ Error
P0704 Clutch Pedal Pos Switch Input Circ Error
P0705 Tran Range Sensor Circ Error
P0706 Tran Range Sensor Circ Range/Perf
P0707 Tran Range Sensor Circ Lo Input
P0708 Tran Range Sensor Circ Hi Input
P0709 Tran Range Sensor Circ Interm
P0710 Tran Fluid Temp Sensor Circ Error 
P0711 Tran Fluid Temp Sensor Circ Range/Perf
P0712 Tran Fluid Temp Sensor CKT Lo Input
P0713 Tran Fluid Temp Sensor CKT Hi Input
P0714 Tran Fluid Temp Sensor Circ Interm
P0715 Input/Turbine Speed Sensor Circ Error
P0716 Input/Turbine Speed Sensor Circ Range/Perf
P0717 Input/Turbine Speed Sensor Circ No Signal
P0718 Input/Turbine Speed Sensor Circ Interm
P0719 Torq Conv/Brake Switch B Circ Lo
P0720 Output Speed Sensor Circ Error 
P0721 Output Speed Sensor Range/Perf
P0722 Output Speed Sensor No Signal
P0723 Output Speed Sensor Interm
P0724 Torq Conv/Brake Switch B Circ Hi
P0725 Eng Speed input Circ Error
P0726 Eng Speed Input Circ Range/Perf
P0727 Eng Speed Input Circ No Signal
P0728 Eng Speed Input Circ Interm
P0729 Gear 6 Incorrect Ratio
P0730 Incorrect Gear Ratio 
P0731 Gear One Ratio Error
P0732 Gear Two Ratio Error
P0733 Gear Three Ratio Error
P0734 Gear Four Ratio Error
P0735 Gear Five Ratio Error
P0736 Reverse Gear Ratio Error
P0737 TCM Eng Speed Output Circ
P0738 TCM Eng Speed Output Circ Lo
P0739 TCM Eng Speed Output Circ Hi
P0740 Torq Conv Clutch Circ MalFunc 
P0741 Torq Conv Clutch Circ Perf/Stuck Off
P0742 Torq Conv Clutch Circ Stuck On
P0743 Torq Conv Clutch Sys Electrical Failure
P0744 Torq Conv Clutch Circ Interm
P0745 Pres Ctrl Solenoid Error
P0746 Pres Ctrl Solenoid Perf/Stuck Off
P0747 Pres Ctrl Solenoid Stuck On
P0748 Pres Ctrl Solenoid Electrical
P0749 Pres Ctrl Solenoid Interm
P0750 Shift Solenoid A Error 
P0751 Shift Solenoid A Perf/Stuck Off
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P0752 Shift Solenoid A Stuck On
P0753 Shift Solenoid A Electrical
P0754 Shift Solenoid A Interm
P0755 Shift Solenoid B Error
P0756 Shift Solenoid B Perf/Stuck Off
P0757 Shift Solenoid B Stuck On
P0758 Shift Solenoid B Electrical
P0759 Shift Solenoid B Interm
P0760 Shift Solenoid C Error 
P0761 Shift Solenoid C Perf/Stuck Off
P0762 Shift Solenoid C Stuck On
P0763 Shift Solenoid C Electrical
P0764 Shift Solenoid C Interm
P0765 Shift Solenoid D Error
P0766 Shift Solenoid D Perf/Stuck Off
P0767 Shift Solenoid D Stuck On
P0768 Shift Solenoid D Electrical
P0769 Shift Solenoid D Interm
P0770 Shift Solenoid E Error 
P0771 Shift Solenoid E Perf/Stuck Off
P0772 Shift Solenoid E Stuck On
P0773 Shift Solenoid E Electrical
P0774 Shift Solenoid E Interm
P0775 Pres Ctrl Solenoid B
P0776 Pres Ctrl Solenoid B Perf/Stuck Off
P0777 Pres Ctrl Solenoid B Stuck On
P0778 Pres Ctrl Solenoid B Electrical
P0779 Pres Ctrl Solenoid B Interm
P0780 Shift Error 
P0781 1-2 Shift Error
P0782 2-3 Shift Error
P0783 3-4 Shift Error
P0784 4-5 Shift Error
P0785 Shift/Timing Solenoid Error
P0786 Shift/Timing Solenoid Range/Perf
P0787 Shift/Timing Solenoid Lo
P0788 Shift/Timing Solenoid Hi
P0789 Shift/Timing Solenoid Interm
P0790 Normal/Perf Switch Circ Error 
P0791 Intermediate Shaft Speed Sensor Circ
P0792 Intermediate Shaft Speed Sensor Circ Range/Perf
P0793 Intermediate Shaft Speed Sensor Circ No Signal
P0794 Intermediate Shaft Speed Sensor Circ Interm
P0795 Pres Ctrl Solenoid C
P0796 Pres Ctrl Solenoid C Perf/Stuck Off
P0797 Pres Ctrl Solenoid C Stuck On
P0798 Pres Ctrl Solenoid C Electrical
P0799 Pres Ctrl Solenoid C Interm
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P0800 - P0999
P0800 Transfer Case Ctrl Sys (MIL Request)
P0801 Reverse Inhibit Ctrl Circ Error
P0802 Trans Ctrl Sys MIL Request Circ/Open
P0803 1-4 Up shift (Skip Shift) Solenoid Ctrl Circ Error
P0804 1-4 Up shift (Skip Shift) Lamp Ctrl Circ Error
P0805 Clutch Pos Sensor Circ
P0806 Clutch Pos Sensor Circ Range/Perf
P0807 Clutch Pos Sensor Circ Lo
P0808 Clutch Pos Sensor Circ Hi
P0809 Clutch Pos Sensor Circ Interm
P0810 Clutch Pos Ctrl Error 
P0811 Excessive Clutch Slippage
P0812 Reverse Input Circ
P0813 Reverse Output Circ
P0814 Tran Range Display Circ
P0815 Up Shift Switch Circ
P0816 Down shift Switch Circ
P0817 Starter Disable Circ
P0818 Driveline Disconnect Switch Input Circ
P0819 Up and Down Shift Switch to Trans Range Correlation
P0820 Gear Lever X-Y Pos Sensor Circ 
P0821 Gear Lever X Pos Sensor Circ
P0822 Gear Lever Y Pos Sensor Circ
P0823 Gear Lever X Pos Sensor Circ Interm
P0824 Gear Lever Y Pos Sensor Circ Interm
P0825 Gear Lever Push/Pull Switch Circ (Shift Anticipate)
P0826 Up and Down Shift Switch Circ
P0827 Up and Down Shift Switch Circ Low
P0828 Up and Down Shift Switch Circ High
P0829 5-6 Shift
P0830 Clutch Pedal Switch A Circ 
P0831 Clutch Pedal Switch A Circ Lo
P0832 Clutch Pedal Switch A Circ Hi
P0833 Clutch Pedal Switch B Circ
P0834 Clutch Pedal Switch B Circ Lo
P0835 Clutch Pedal Switch B Circ Hi
P0836 4WD Switch Circ
P0837 4WD Switch Circ Range/Perf
P0838 4WD Switch Circ Lo
P0839 4WD Switch Circ Hi
P0840 Tran Fluid Pres Sensor/Switch A Circ 
P0841 Tran Fluid Pres Sensor/Switch A Circ Range/Perf
P0842 Tran Fluid Pres Sensor/Switch A Circ Lo
P0843 Tran Fluid Pres Sensor/Switch A Circ Hi
P0844 Tran Fluid Pres Sensor/Switch A Circ Interm
P0845 Tran Fluid Pres Sensor/Switch B Circ
P0846 Tran Fluid Pres Sensor/Switch B Circ Range/Perf
P0847 Tran Fluid Pres Sensor/Switch B Circ Lo
P0848 Tran Fluid Pres Sensor/Switch B Circ Hi
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P0849 Tran Fluid Pres Sensor/Switch B Circ Interm
P0850 Park/Neutral Switch Input Circ 
P0851 Park/Neutral Switch Input Circ Low
P0852 Park/Neutral Switch Input Circ High
P0853 Drive Switch Input Circ
P0854 Drive Switch Input Circ Low
P0855 Drive Switch Input Circ High
P0856 Traction Ctrl Input Signal
P0857 Traction Ctrl Input Signal Range/Perf
P0858 Traction Ctrl Input Signal Low
P0859 Traction Ctrl Input Signal High
P0860 Gear Shift Mod Comm Circ 
P0861 Gear Shift Mod Comm Circ Low
P0862 Gear Shift Mod Comm Circ High
P0863 TCM Comm Circ
P0864 TCM Comm Circ Range/Perf
P0865 TCM Comm Circ Low
P0866 TCM Comm Circ High
P0867 Trans Fluid Press
P0868 Trans Fluid Press Low
P0869 Trans Fluid Press High
P0870 Trans Fluid Press Sensor/Switch C Circ 
P0871 Trans Fluid Press Sensor/Switch C Circ Range/Perf
P0872 Trans Fluid Press Sensor/Switch C Circ Low
P0873 Trans Fluid Press Sensor/Switch C Circ High
P0874 Trans Fluid Press Sensor/Switch C Circ Interm
P0875 Trans Fluid Press Sensor/Switch D Circ
P0876 Trans Fluid Press Sensor/Switch D Circ Range/Perf
P0877 Trans Fluid Press Sensor/Switch D Circ Low
P0878 Trans Fluid Press Sensor/Switch D Circ High
P0879 Trans Fluid Press Sensor/Switch D Circ Interm
P0880 TCM Power Input Signal 
P0881 TCM Power Input Signal Range/Perf
P0882 TCM Power Input Signal Low
P0883 TCM Power Input Signal High
P0884 TCM Power Input Signal Interm
P0885 TCM Power Relay Ctrl Circ/Open
P0886 TCM Power Relay Ctrl Circ Low
P0887 TCM Power Relay Ctrl Circ High
P0888 TCM Power Relay Sense Circ
P0889 TCM Power Relay Sense Circ Range/Perf
P0890 TCM Power Relay Sense Circ Low 
P0891 TCM Power Relay Sense Circ High
P0892 TCM Power Relay Sense Circ Interm
P0893 Multiple Gears Engaged
P0894 Trans Component Slipping
P0895 Shift Time Too Short
P0896 Shift Time Too Long
P0897 Trans Fluid Deteriorated
P0898 Trans Ctrl Sys MIL Request Circ Low
P0900 Clutch Actuator Circ/Open 
P0901 Clutch Actuator Circ Range/Perf
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P0902 Clutch Actuator Circ Low
P0903 Clutch Actuator Circ High
P0904 Gate Select Pos Circ
P0905 Gate Select Pos Circ Range/Perf
P0906 Gate Select Pos Circ Low
P0907 Gate Select Pos Circ High
P0908 Gate Select Pos Circ Interm
P0909 Gate Select Ctrl Error
P0910 Gate Select Actuator Circ/Open 
P0911 Gate Select Actuator Circ Range/Perf
P0912 Gate Select Actuator Circ Low
P0913 Gate Select Actuator Circ High
P0914 Gear Shift Pos Circ
P0915 Gear Shift Pos Circ Range/Perf
P0916 Gear Shift Pos Circ Low
P0917 Gear Shift Pos Circ High
P0918 Gear Shift Pos Circ Interm
P0919 Gear Shift Pos Ctrl Error
P0920 Gear Shift Forward Actuator Circ/Open 
P0921 Gear Shift Forward Actuator Circ Range/Perf
P0922 Gear Shift Forward Actuator Circ Low
P0923 Gear Shift Forward Actuator Circ High
P0924 Gear Shift Reverse Actuator Circ/Open
P0925 Gear Shift Reverse Actuator Circ Range/Perf
P0926 Gear Shift Reverse Actuator Circ Low
P0927 Gear Shift Reverse Actuator Circ High
P0928 Gear Shift Lock Solenoid Ctrl Circ/Open
P0929 Gear Shift Lock Solenoid Ctrl Circ Range/Perf
P0930 Gear Shift Lock Solenoid Ctrl Circ Low 
P0931 Gear Shift Lock Solenoid Ctrl Circ High
P0932 Hydraulic Press Sensor Circ
P0933 Hydraulic Press Sensor Range/Perf
P0934 Hydraulic Press Sensor Circ Low
P0935 Hydraulic Press Sensor Circ High
P0936 Hydraulic Press Sensor Circ Interm
P0937 Hydraulic Oil Temp Sensor Circ
P0938 Hydraulic Oil Temp Sensor Range/Perf
P0939 Hydraulic Oil Temp Sensor Circ Low
P0940 Hydraulic Oil Temp Sensor Circ High 
P0941 Hydraulic Oil Temp Sensor Circ Interm
P0942 Hydraulic Press Unit
P0943 Hydraulic Press Unit Cycling Period Too Short
P0944 Hydraulic Press Unit Loss of Press
P0945 Hydraulic Pump Relay Circ/Open
P0946 Hydraulic Pump Relay Circ Range/Perf
P0947 Hydraulic Pump Relay Circ Low
P0948 Hydraulic Pump Relay Circ High
P0949 Auto Shift Manual Adaptive Learning Not Complete
P0950 Auto Shift Manual Ctrl Circ 
P0951 Auto Shift Manual Ctrl Circ Range/Perf
P0952 Auto Shift Manual Ctrl Circ Low
P0953 Auto Shift Manual Ctrl Circ High



B.U.D.S. User ManualUser interface > Faults

  124 www.diag-systems.com

P0954 Auto Shift Manual Ctrl Circ Interm
P0955 Auto Shift Manual Mode Circ
P0956 Auto Shift Manual Mode Circ Range/Perf
P0957 Auto Shift Manual Mode Circ Low
P0958 Auto Shift Manual Mode Circ High
P0959 Auto Shift Manual Mode Circ Interm
P0960 Press Ctrl Solenoid A Ctrl Circ/Open 
P0961 Press Ctrl Solenoid A Ctrl Circ Range/Perf
P0962 Press Ctrl Solenoid A Ctrl Circ Low
P0963 Press Ctrl Solenoid A Ctrl Circ High
P0964 Press Ctrl Solenoid B Ctrl Circ/Open
P0965 Press Ctrl Solenoid B Ctrl Circ Range/Perf
P0966 Press Ctrl Solenoid B Ctrl Circ Low
P0967 Press Ctrl Solenoid B Ctrl Circ High
P0968 Press Ctrl Solenoid C Ctrl Circ/Open
P0969 Press Ctrl Solenoid C Ctrl Circ Range/Perf
P0970 Press Ctrl Solenoid C Ctrl Circ Low 
P0971 Press Ctrl Solenoid C Ctrl Circ High
P0972 Shift Solenoid A Ctrl Circ Range/Perf
P0973 Shift Solenoid A Ctrl Circ Low
P0974 Shift Solenoid A Ctrl Circ High
P0975 Shift Solenoid B Ctrl Circ Range/Perf
P0976 Shift Solenoid B Ctrl Circ Low
P0977 Shift Solenoid B Ctrl Circ High
P0978 Shift Solenoid C Ctrl Circ Range/Perf
P0979 Shift Solenoid C Ctrl Circ Low
P0980 Shift Solenoid C Ctrl Circ High 
P0981 Shift Solenoid D Ctrl Circ Range/Perf
P0982 Shift Solenoid D Ctrl Circ Low
P0983 Shift Solenoid D Ctrl Circ High
P0984 Shift Solenoid E Ctrl Circ Range/Perf
P0985 Shift Solenoid E Ctrl Circ Low
P0986 Shift Solenoid E Ctrl Circ High P0987 Trans Fluid Press Sensor/Switch E Circ
P0988 Trans Fluid Press Sensor/Switch E Circ Range/Perf
P0989 Trans Fluid Press Sensor/Switch E Circ Low
P0990 Trans Fluid Press Sensor/Switch E Circ High 
P0991 Trans Fluid Press Sensor/Switch E Circ Interm
P0992 Trans Fluid Press Sensor/Switch F Circ
P0993 Trans Fluid Press Sensor/Switch F Circ Range/Perf
P0994 Trans Fluid Press Sensor/Switch F Circ Low
P0995 Trans Fluid Press Sensor/Switch F Circ High
P0996 Trans Fluid Press Sensor/Switch F Circ Interm
P0997 Shift Solenoid F Ctrl Circ Range/Perf
P0998 Shift Solenoid F Ctrl Circ Low
P0999 Shift Solenoid F Ctrl Circ High
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P0A00 - P0A29
P0A00 Motor Electronics Coolant Temp Sensor Circ
P0A01 Motor Electronics Coolant Temp Sensor Circ Range/Perf
P0A02 Motor Electronics Coolant Temp Sensor Circ Low
P0A03 Motor Electronics Coolant Temp Sensor Circ High
P0A04 Motor Electronics Coolant Temp Sensor Circ Interm
P0A05 Motor Electronics Coolant Pump Ctrl Circ/Open
P0A06 Motor Electronics Coolant Pump Ctrl Circ Low
P0A07 Motor Electronics Coolant Pump Ctrl Circ High
P0A08 DC/DC Converter Status Circ
P0A09 DC/DC Converter Status Circ Low Input
P0A10 DC/DC Converter Status Circ High Input 
P0A11 DC/DC Converter Enable Circ/Open
P0A12 DC/DC Converter Enable Circ Low
P0A13 DC/DC Converter Enable Circ High
P0A14 Engine Mount Ctrl Circ/Open
P0A15 Engine Mount Ctrl Circ Low
P0A16 Engine Mount Ctrl Circ High
P0A17 Motor Torque Sensor Circ
P0A18 Motor Torque Sensor Circ Range/Perf
P0A19 Motor Torque Sensor Circ Low
P0A20 Motor Torque Sensor Circ High 
P0A21 Motor Torque Sensor Circ Interm
P0A22 Generator Torque Sensor Circ
P0A23 Generator Torque Sensor Circ Range/Perf
P0A24 Generator Torque Sensor Circ Low
P0A25 Generator Torque Sensor Circ High
P0A26 Generator Torque Sensor Circ Interm
P0A27 Battery Power Off Circ
P0A28 Battery Power Off Circ Low
P0A29 Battery Power Off Circ High



B.U.D.S. User ManualUser interface > Faults

  126 www.diag-systems.com

P1000 - P1399
P1000 Monitor Checks Not Complete-More Driving Required
P1105 Sec Vacuum Sensor Circ
P1106 MAP Sens Circ Interm Hi Volts
P1107 MAP Sens Circ Interm Lo Volts
P1108 BARO to MAP Sens Comparison Too Hi
P1109 Sec Port Throttle Sys 
P1111 Intake Air Temp Sens Circ Interm Hi Volts
P1112 Intake Air Temp Sens Circ Interm Lo Volts
P1113 Intake Resonance Switchover Solenoid Ctrl Circ
P1114 Eng Coolant Temp Sens Circ Interm Lo Volts
P1115 Eng Coolant Temp Sens Circ Interm Hi Volts
P1116 Eng Coolant Temp Sig Unstable or Interm
P1117 Eng Coolant Temp Sig Out-Of-Range Lo
P1118 Eng Coolant Temp Sig Out-Of-Range Hi
P1119 Eng Coolant Temp Sig Out-Of-Range With TFT Sens
P1120 Throttle Pos Sens1 Circ 
P1121 Throttle Pos Sens Circ Interm Hi Volts
P1122 Throttle Pos Sens Circ Interm Lo Volts
P1125 APP Sys
P1130 HO2S Circ Lo Variance Bank1 Sens1
P1131 HO2S Circ Lo Variance Bank1 Sens2
P1132 HO2S Circ Lo Variance Bank2 Sens1
P1133 HO2S Insufficient Switching Bank1 Sens1
P1134 HO2S Transition Time Ratio Bank1 Sens1
P1135 HO2S Lean Mean Bank1 Sens1
P1136 HO2S Rich Mean Bank1 Sens1
P1137 HO2S Bank1 Sens2 Lean Sys or Lo Volts
P1138 HO2S Bank1 Sens2 Rich or Hi Volts
P1139 HO2S Insuff Switching Bank1 Sens2
P1140 HO2S Transition Time Ratio Bank1 Sens2 
P1141 HO2S Heater Ctrl Circ Bank1 Sens2
P1143 HO2S Bank1 Sens3 Lean Sys or Lo Volts
P1144 HO2S Bank1 Sens3 Rich or Hi Volts 
P1153 HO2S Insufficient Switching Bank2 Sens1
P1154 HO2S Transition Time Ratio Bank2 Sens1
P1155 HO2S Lean Mean Bank2 Sens1
P1156 HO2S Rich Mean Bank2 Sens1
P1157 HO2S Bank2 Sens2 Lean Sys or Lo Volts
P1158 HO2S Bank2 Sens2 Rich or Hi Volts
P1159 HO2S Cross Counts Bank2 Sens2 
P1164 HO2S Bank2 Sens3 Rich or Hi Volts
P1165 HO2S Cross Counts Bank2 Sens3 
P1170 Bank to Bank Fuel Trim Offset
P1171 Fuel Sys Lean during Acceleration 
P1185 Eng Oil Temp Circ
P1186 EOT Circ Perf
P1187 EOT Sens Circ Lo Volts
P1188 EOT Sens Circ Hi Volts
P1189 Eng Oil Press (EOP) Switch Circ
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P1190 Eng Vacuum Leak
P1191 Intake Air Duct Air Leak
P1200 Injector Ctrl Circ 
P1201 (Alt. Fuel) Gas Mass Sens Circ Range/Perf
P1202 (Alt. Fuel) Gas Mass Sens Circ Lo Freq
P1203 (Alt. Fuel) Gas Mass Sens Circ Hi Freq 
P1211 Mass Air Flow Circ Interm Hi
P1212 Mass Air Flow Circ Interm Lo
P1214 Inject Pump Timing Offset
P1215 Gnd Fault Detection Indicated
P1216 Fuel Solenoid Response Time Too Short
P1217 Fuel Solenoid Response Time Too Long
P1218 Inject Pump Calibration Circ
P1219 Throttle Pos Sens Ref Volts
P1220 Throttle Pos (TP) Sens2 Circ 
P1221 Fuel Pump Sec Circ Lo
P1222 Injector Ctrl Circ Interm
P1225 Injector Circ Cyl2 Interm
P1228 Injector Circ Cyl3 Interm 
P1231 Injector Circ Cyl4 Interm
P1234 Injector Circ Cyl5 Interm
P1237 Injector Circ Cyl6 Interm
P1240 Injector Circ Cyl7 Interm 
P1243 Injector Circ Cyl8 Interm
P1245 Intake Plenum Switchover Valve
P1250 Early Fuel Evaporation Heater Circ 
P1257 Supercharger Sys Over boost
P1258 Eng Coolant over Temp-Protection Mode Active
P1260 Last Test Failed SCC ENTER More Info. 
P1270 Accelerator Pedal Pos Sens A/D Converter Error
P1271 Accelerator Pedal Pos (APP) Sens1-2 Correlation
P1272 Accelerator Pedal Pos Sens2
P1273 Accelerator Pedal Pos Sens1
P1274 Injectors Wired Incorrectly
P1275 Accelerator Pedal Pos (APP) Sens1 Circ
P1276 Accelerator Pedal Pos Sens1 Circ Perf
P1277 Accelerator Pedal Pos Sens1 Circ Lo Volts
P1278 Accelerator Pedal Pos Sens1 Circ Hi Volts
P1280 Accelerator Pedal Pos (APP) Sens2 Circ 
P1281 Accelerator Pedal Pos Sens2 Circ Perf
P1282 Accelerator Pedal Pos Sens2 Circ Lo Volts
P1283 Accelerator Pedal Pos Sens2 Circ Hi Volts
P1285 Accelerator Pedal Pos Sens3 Circ
P1286 Accelerator Pedal Pos Sens3 Circ Perf
P1287 Accelerator Pedal Pos Sens3 Circ Lo Volts
P1288 Accelerator Pedal Pos Sens3 Circ Hi Volts 
P1300 Igniter Circ
P1305 Ign Coil 2 Pri Feedback Circ
P1310 Ign Coil 3 Pri Feedback Circ 
P1315 Ign Coil 4 Pri Feedback Circ
P1320 C 4X Ref Circ Interm 
P1321 Electronic Ign Sys Fault Line
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P1322 EI Sys or Ign Ctrl Extra or Missing
P1323 IC 24X Ref Circ Lo Freq
P1324 Crank RPM Too Lo 
P1335 CKP Circ
P1336 Crank Pos (CKP) Sys Variation Not Learned 
P1345 Crank Pos (CKP)-Camshaft Pos (CMP) Correlation
P1346 Intake Camshaft Pos [CMP] Sens Sys Perf
P1350 Ign Ctrl Sys 
P1351 Ign Coil Ctrl Circ Hi Volts
P1352 IC Output Hi/Pulse Detected when GND Cyl. 2
P1353 IC Output Hi/Pulse Detected when GND Cyl. 3
P1354 IC Output Hi/Pulse Detected when GND Cyl. 4
P1355 IC Output Hi/Pulse Detected when GND Cyl. 5
P1356 IC Output Hi/Pulse Detected when GND Cyl. 6
P1357 IC Output Hi/Pulse Detected when GND Cyl. 7
P1358 IC Output Hi/Pulse Detected when GND Cyl. 8
P1359 Ignition Coil Group 1 Ctrl Circ
P1360 Ignition Coil Group 2 Ctrl Circ 
P1361 Ignition Coil Ctrl Circ Lo Volts
P1362 IC Cyl2 Not Toggling After Enable
P1363 IC Cyl3 Not Toggling After Enable
P1364 IC Cyl4 Not Toggling After Enable
P1365 IC Cyl5 Not Toggling After Enable
P1366 IC Cyl6 Not Toggling After Enable
P1367 IC Cyl7 Not Toggling After Enable
P1368 IC Cyl8 Not Toggling After Enable
P1370 IC 4X Ref Circ Too Many Pulses 
P1371 IC 4X Ref Circ Too Few Pulses
P1372 Crank Pos (CKP) SensorA-B Correlation
P1374 3X Ref Circ
P1375 IC 24X Ref Circ Hi Volts
P1376 Ignition Gnd Circ
P1377 IC Cam Pulse To 4X Ref Pulse
P1380 Misfire Detected-Rough Road Data Not Available 
P1381 Misfire Detected-No Comm with Brake Ctrl Mod
P1390 Wheel Speed Sensor1-G-Sensor Circ 
P1391 Wheel Speed Sensor1-G-Sensor Circ Perf
P1392 Wheel Speed Sensor1-G-Sensor Circ Lo Volts
P1393 Wheel Speed Sensor1-G-Sensor Circ Hi Volts
P1394 Wheel Speed Sensor1-G-Sensor Circ Interm
P1395 Wheel Speed Sensor2-G-Sensor Circ
P1396 Wheel Speed Sensor2-G-Sensor Circ Perf
P1397 Wheel Speed Sensor2-G-Sensor Circ Lo Volts
P1398 Wheel Speed Sensor2-G-Sensor Circ Hi Volts
P1399 Wheel Speed Sensor2-G-Sensor Circ Interm
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P1400 - P1599
P1403 Exhaust Gas Recirc Sys Valve 1
P1404 Exhaust Gas Recirc (EGR) Closed Pos Perf
P1405 Exhaust Gas Recirc Sys Valve 3
P1406 EGR Valve Pintle Pos Circ
P1407 EGR Air Intrusion in Exhaust Supply to EGR Valve
P1408 Intake Manifold Press Sensor Circ
P1409 EGR Vacuum Sys Leak
P1410 Fuel Tank Press Sys 
P1415 Sec Air Inject (AIR) Sys Bank1
P1416 Sec Air Inject (AIR) Sys Bank2
P1418 Sec Air Inject Sys Relay A Ctrl Circ Hi
P1420 Intake Air Lo Press Switch Circ Lo Volts 
P1421 Intake Air Lo Press Switch Circ Hi Volts
P1423 Intake Air Hi Press Switch Circ Hi Volts 
P1431 Fuel Level Sensor2 Circ Perf
P1432 Fuel Level Sensor2 Circ Lo Volts
P1433 Fuel Level Sensor2 Circ Hi Volts 
P1441 EVAP Emission Sys Flow during Non-Purge
P1442 EVAP Vacuum Sw. Hi Volts during Ignition. On
P1450 Barometric Press Sensor Circ 
P1451 Barometric Press Sensor Perf
P1460 Cooling Fan Ctrl Sys 
P1480 Fan Sec Lo With Lo Fan On
P1481 Fan Sec Lo With Hi Fan On
P1483 Eng Cooling Sys Perf 
P1500 Starter Signal Circ
P1501 Vehicle Speed Sensor Circ Interm
P1501 Theft Deterrent Sys
P1502 Theft Deterrent Fuel Enable Signal Not
P1503 Theft Deterrent Sys-Password Incorrect
P1504 Vehicle Speed Output Circ
P1508 IAC Sys Lo RPM
P1509 IAC Sys Hi RPM 
P1510 Back Up Power Supply
P1511 Throttle Ctrl Sys-Backup Sys Perf
P1514 Air Flow to TP Sensor Correlation Hi
P1515 Electronic Throttle Sys Throttle Pos
P1516 Electronic Throttle Mod Throttle Pos
P1517 Electronic Throttle Mod
P1518 Electronic Throttle Mod to PCM Comm
P1519 Electronic Throttle Mod Lo Volts Comm. Disable 
P1520 Gear Indicator Sys
P1521 Trans Engaged at Hi Throttle Angle
P1522 Park/Neutral to Drive/Reverse at Hi RPM
P1523 Elec. Throttle Ctrl Throttle Return
P1524 TP Sen. Learned Cl. Throttle. Angle ? Out of Range
P1525 Throttle Body Service Required
P1526 TP Sensor Learn Not Complete
P1527 Trans. Range/Press Switch Comparison
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P1528 Governor
P1529 Heated Windshield Request Problem 
P1530 Ignition Timing Adjustment Switch Circ
P1531 A/C Lo Side Temp Sensor Fault
P1532 A/C Evaporator Temp Sensor Circ Lo Voltage
P1533 A/C Evaporator Temp Sensor Circ Hi Voltage
P1534 A/C Hi Side Temp. Sensor Lo Voltage
P1535 A/C Hi Side Temp Sensor Circ
P1536 A/C Sys-ECT Over Temp
P1537 A/C Request Circ Lo Voltage
P1538 A/C Request Circ Hi Voltage
P1539 A/C Clutch Status Circ High Volts 
P1540 A/C Sys Hi Press
P1541 A/C Hi Side Over Temp
P1542 A/C Sys Hi Press Hi Temp
P1543 A/C Sys Perf
P1544 A/C Refrigerant Condition Very Lo
P1545 A/C Clutch Relay Ctrl Circ
P1546 A/C Clutch Status Circ Lo Voltage
P1547 A/C Sys Perf Degraded
P1548 A/C Recirculation Circ 
P1554 Cruise Engaged Circ Hi Voltage
P1555 Electronic Variable Orifice Output
P1558 Cruise Ctrl Servo Indicates Lo
P1559 Cruise Ctrl Power Mgmt Mode 
P1560 Cruise Ctrl Sys-Transaxle Not In Drive
P1561 Cruise Vent Solenoid
P1562 Cruise Vacuum Solenoid
P1563 Cruise Vehicle Speed/Set Speed Difference Too Hi
P1564 Cruise Ctrl Sys-Vehicle Accel Too Hi
P1565 Cruise Servo Pos Sensor
P1566 Cruise Ctrl Sys-Engine RPM Too Hi
P1567 Cruise Ctrl Sys-Active Braking Ctrl Active
P1568 Cruise Servo Stroke Greater than Commanded in Cruise
P1569 Cruise Servo Stroke Hi While not in Cruise 
P1570 Cruise Ctrl Sys-Traction Ctrl Active
P1571 TCS PWM Circ No Frequency
P1572 ASR Active Circ Lo Too Long
P1573 PCM/EBTCM Serial Data Circ
P1574 EBTCM Sys-Stop Lamp Switch Circ Hi Volts
P1575 Extended Travel Brake Sw. Circ Hi Volts
P1576 BBV Sensor Circ Hi Voltage
P1577 BBV Sensor Circ Lo Voltage
P1578 BBV Sensor Circ Lo Vacuum
P1579 P/N to D/R at Hi Throttle Angle 
P1580 Cruise Move Circ Lo Voltage
P1581 Cruise Move Circ Hi Voltage
P1582 Cruise Direction Circ Lo Voltage
P1583 Cruise Direction Circ Hi Voltage
P1584 Cruise Ctrl Disabled
P1585 Cruise Inhibit Ctrl Circ
P1586 Cruise Ctrl Brake Switch 2 Circ
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P1587 Cruise Ctrl Clutch Ctrl Circ Lo
P1588 Cruise Ctrl Clutch Ctrl Circ Hi 
P1599 Eng Stall or Near Stall Detected
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P1600 - P1799
P1600 PCM Battery/TCM Watchdog
P1601 Serial Comm. Problem with Device 1
P1602 Loss of EBTCM Serial Data
P1603 Loss of SDM Serial Data
P1604 Loss of IPC Serial Data
P1605 Loss of HVAC Serial Data
P1606 Serial Comm Problem with Device 6
P1607 Serial Comm Problem with Device 7
P1608 Serial Comm Problem with Device 8
P1609 Loss of TCS Serial Data 
P1610 Loss of PZM Serial Data
P1611 Loss of CVRTD Serial Data
P1612 Loss of IPM Serial Data
P1613 Loss of DIM Serial Data
P1614 Loss of RIM Serial Data
P1615 Loss of VTD Serial Data
P1617 Engine Oil Level Switch Circ
P1619 Engine Oil Life Monitor Reset Circ 
P1620 Lo Coolant Circ
P1621 PCM Memory Perf
P1622 Cylinder Select
P1623 Trans Temp Pull-Up Resistor
P1624 Customer Snapshot Data Available
P1625 PCM Sys Reset
P1626 Theft Deterrent Sys Fuel Enable Circ
P1627 A/D Perf
P1628 ECT Pull-Up Resistor
P1629 Theft Deterrent Sys-Cranking Signal 
P1630 Theft Deterrent Sys-PCM In Learn Mode
P1631 Theft Deterrent Sys-Password Incorrect
P1632 Theft Deterrent Sys-Fuel disabled
P1633 Ignition Supply Power Circ Lo Voltage
P1634 Ignition 1 Power Circ Lo Voltage
P1635 5 Volt Ref Lo
P1636 PCM Stack Overrun
P1637 Generator L-Terminal Circ
P1638 Generator F-Terminal Circ
P1639 5 Volt Ref 2 Circ 
P1640 Driver 1-Input Hi Voltage
P1641 FC Relay 1 Ctrl Circ
P1642 FC Relay 2 and 3 Ctrl Circ
P1643 Engine Speed Output Circ
P1644 Traction Ctrl Delivered Torque Output Circ
P1645 EVAP Emission (EVAP) Vent Solenoid Ctrl Circ
P1646 Driver 1 Line 6
P1647 Driver 1 Line 7 
P1650 Driver 2-Input Hi Voltage
P1651 Fan 1 Relay Ctrl Circ
P1652 VSS Output Circ
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P1653 Oil Level Lamp Ctrl Circ
P1654 Service Throttle Soon Lamp Ctrl Circ
P1655 EVAP Purge Solenoid Ctrl Circ
P1656 Driver 2 Line 6
P1657 1-4 Up shift Solenoid Ctrl Circ
P1658 Starter Enable Relay Ctrl Circ 
P1660 Cooling Fans Ctrl Circ
P1661 MIL Ctrl Circ
P1662 Cruise Ctrl Inhibit Ctrl Circ
P1663 Oil Life Lamp Ctrl Circ
P1664 1-4 Up shift Lamp Ctrl Circ
P1665 Driver 3 Line 5
P1666 Driver 3 Line 6
P1667 Reverse Inhibit Solenoid Ctrl Circ
P1669 ABS Unit Expected 
P1670 Driver 4
P1671 Driver 4 Line 1
P1672 Lo Engine Oil Level Lamp Ctrl Circ
P1673 Engine Hot Lamp Ctrl Circ
P1674 Tachometer Ctrl Circ
P1675 EVAP Vent Solenoid Ctrl Circ
P1676 Driver 4 Line 6
P1677 Driver 4 Line 7 
P1680 Driver 5
P1681 Driver 5 Line 1
P1682 Driver 5 Line 2
P1683 Driver 5 Line 3
P1684 Driver 5 Line 4
P1685 Driver 5 Line 5
P1686 Driver 5 Line 6
P1687 Driver 5 Line 7
P1689 Delivered Torque Circ Fault 
P1690 ECM Loop Overrun
P1691 Coolant Gage Circ Lo Voltage
P1692 Coolant Gage Circ Hi Voltage
P1693 Tachometer Circ Lo Voltage
P1694 Tachometer Circ Hi Voltage
P1695 Remote Keyless Entry Circ Lo
P1696 Remote Keyless Entry Voltage Hi 
P1700 Trans. MIL Request
P1701 Trans. MIL Request Circ
P1705 P/N Signal Output Circ 
P1740 Torque Reduction Signal Circ
P1743 TP Signal from ECM 
P1760 TCM Supply Volts Interrupted 
P1779 Eng Torque Delivered to TCM Signal 
P1780 Park/Neutral Pos [PNP] Switch Circ
P1781 Eng Torque Signal Circ 
P1790 Trans Ctrl Mod Checksum
P1791 Trans Ctrl Mod Loop
P1792 Trans Ctrl Mod Reprogrammable Memory
P1792 ECM to TCM Eng Coolant Signal
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P1793 Trans Ctrl Mod Stack Overrun
P1795 CAN Bus-Throttle Body Pos
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P1800 - P1899
P1800 TCM Power Relay Ctrl Circ
P1801 Perf Selector Switch Failure
P1804 Gnd Ctrl Relay 
P1810 TFP Valve Pos Switch Circ
P1811 Maximum Adapt and Long Shift
P1812 Trans over Temp Condition
P1813 Torque Ctrl
P1814 Torq Conv Overstressed
P1815 Trans Range Switch-Start In Wrong Range
P1816 TFP Valve Pos Sw.-Park/Neutral with Drive Ratio
P1817 TFP Valve Pos Sw.-Reverse With Drive Ratio
P1818 TFP Valve Pos Sw.-Drive Without Drive Ratio
P1819 Internal Mode Switch-No Start\Wrong Range 
P1820 Internal Mode Switch Circ A Low
P1822 Internal Mode Switch Circ B High
P1823 Internal Mode Switch Circ P Low
P1825 Internal Mode Switch-Invalid Range
P1826 Internal Mode Switch Circ C-High 
P1831 PC Solenoid Power Circ-Low Volts
P1833 A/T Solenoids Power Circ-Low Volts
P1835 Kick-Down Switch Circ
P1836 Kick-Down Switch Failed Open
P1837 Kick-Down Switch Failed Short 
P1842 1-2 Shift Solenoid Circ Low Volts
P1843 1-2 Shift Solenoid Circ High Volts
P1844 Torque Reduction Signal Circ Desired By TCM
P1845 2-3 Shift Solenoid Circ Low Volts
P1847 2-3 Shift Solenoid Circ High Volts 
P1850 Brake Band Apply Solenoid Circ
P1851 Brake Band Apply Solenoid Perf
P1852 Brake Band Apply Solenoid Low Volts
P1853 Brake Band Apply Solenoid High Volts 
P1860 TCC PWM Solenoid Circ Electrical
P1864 Torq Conv Clutch Circ
P1868 Trans Fluid Life 
P1870 Trans Component Slipping
P1871 Undefined Gear Ratio
P1873 TCC Stator Temp Switch Circ Low
P1874 TCC Stator Temp Switch Circ High
P1875 4WD Low Switch Circ Electrical 
P1884 TCC Enable/Shift Light Circ
P1886 Shift Timing Solenoid
P1887 TCC Release Switch Circ 
P1890 ECM Data Input Circ
P1890 Throttle Pos Signal Input
P1891 Throttle Pos Sensor PWM Signal Low
P1892 Throttle Pos Sensor PWM Signal High
P1893 Eng Torque Signal Low Volts
P1894 Eng Torque Signal High Volts
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P1895 TCM to ECM Torque Reduction Circ
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P2000 - P2143
P2000 NOx Trap Efficiency Below Threshold Bank1
P2001 NOx Trap Efficiency Below Threshold Bank2
P2002 Particulate Trap Efficiency Below Threshold Bank1
P2003 Particulate Trap Efficiency Below Threshold Bank2
P2004 Intake Manifold Runner Ctrl Stuck Open Bank1
P2005 Intake Manifold Runner Ctrl Stuck Open Bank2
P2006 Intake Manifold Runner Ctrl Stuck Closed Bank1
P2007 Intake Manifold Runner Ctrl Stuck Closed Bank2
P2008 Intake Manifold Runner Ctrl Circ/Open Bank1
P2009 Intake Manifold Runner Ctrl Circ Low Bank1 
P2010 Intake Manifold Runner Ctrl Circ High Bank1
P2011 Intake Manifold Runner Ctrl Circ/Open Bank2
P2012 Intake Manifold Runner Ctrl Circ Low Bank2
P2013 Intake Manifold Runner Ctrl Circ High Bank2
P2014 Intake Manifold Runner Pos Sensor/Switch Circ Bank1
P2015 Intake Manifold Runner Pos Sensor/Switch Circ Range/Perf Bank1
P2016 Intake Manifold Runner Pos Sensor/Switch Circ Low Bank1
P2017 Intake Manifold Runner Pos Sensor/Switch Circ High Bank1
P2018 Intake Manifold Runner Pos Sensor/Switch Circ Interm Bank1
P2019 Intake Manifold Runner Pos Sensor/Switch Circ Bank2 
P2020 Intake Manifold Runner Pos Sensor/Switch Circ Range/Perf Bank2
P2021 Intake Manifold Runner Pos Sensor/Switch Circ Low Bank2
P2022 Intake Manifold Runner Pos Sensor/Switch Circ High Bank2
P2023 Intake Manifold Runner Pos Sensor/Switch Circ Interm Bank2
P2024 EVAP Fuel Vapor Temp Sensor Circ
P2025 EVAP Fuel Vapor Temp Sensor Perf
P2026 EVAP Fuel Vapor Temp Sensor Circ Low Voltage
P2027 EVAP Fuel Vapor Temp Sensor Circ High Voltage
P2028 EVAP Fuel Vapor Temp Sensor Circ Interm
P2029 Fuel Fired Heater Disabled 
P2030 Fuel Fired Heater Perf
P2031 Exhaust Gas Temp Sensor Circ Bank1 Sensor 2
P2032 Exhaust Gas Temp Sensor Circ Low Bank1 Sensor 2
P2033 Exhaust Gas Temp Sensor Circ High Bank1 Sensor 2
P2034 Exhaust Gas Temp Sensor Circ Bank2 Sensor 2
P2035 Exhaust Gas Temp Sensor Circ Low Bank2 Sensor 2
P2036 Exhaust Gas Temp Sensor Circ High Bank2 Sensor 2
P2037 Reductant Inj Air Press Sensor Circ
P2038 Reductant Inj Air Press Sensor Circ Range/Perf
P2039 Reductant Inj Air Press Sensor Circ Low Input 
P2040 Reductant Inj Air Press Sensor Circ High Input
P2041 Reductant Inj Air Press Sensor Circ Interm
P2042 Reductant Temp Sensor Circ
P2043 Reductant Temp Sensor Circ Range/Perf
P2044 Reductant Temp Sensor Circ Low Input
P2045 Reductant Temp Sensor Circ High Input
P2046 Reductant Temp Sensor Circ Interm
P2047 Reductant Injector Circ/Open Bank1 Unit 1
P2048 Reductant Injector Circ Low Bank1 Unit 1
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P2049 Reductant Injector Circ High Bank1 Unit 1 
P2050 Reductant Injector Circ/Open Bank2 Unit 1
P2051 Reductant Injector Circ Low Bank2 Unit 1
P2052 Reductant Injector Circ High Bank2 Unit 1
P2053 Reductant Injector Circ/Open Bank1 Unit 2
P2054 Reductant Injector Circ Low Bank1 Unit 2
P2055 Reductant Injector Circ High Bank1 Unit 2
P2056 Reductant Injector Circ/Open Bank2 Unit 2
P2057 Reductant Injector Circ Low Bank2 Unit 2
P2058 Reductant Injector Circ High Bank2 Unit 2
P2059 Reductant Inj Air Pump Ctrl Circ/Open 
P2060 Reductant Inj Air Pump Ctrl Circ Low
P2061 Reductant Inj Air Pump Ctrl Circ High
P2062 Reductant Supply Ctrl Circ/Open
P2063 Reductant Supply Ctrl Circ Low
P2064 Reductant Supply Ctrl Circ High
P2065 Fuel Level SensorB Circ
P2066 Fuel Level SensorB Perf
P2067 Fuel Level SensorB Circ Low
P2068 Fuel Level SensorB Circ High
P2069 Fuel Level SensorB Circ Interm 
P2070 Intake Manifold Tuning (IMT) Valve Stuck Open
P2071 IMT Valve Stuck Closed
P2075 IMT Valve Pos Sensor/Switch Circ
P2076 IMT Valve Pos Sensor/Switch Circ Range/Perf
P2077 IMT Valve Pos Sensor/Switch Circ Low
P2078 IMT Valve Pos Sensor/Switch Circ High
P2079 IMT Valve Pos Sensor/Switch Circ Interm 
P2080 Exhaust Gas Temp Sensor Circ Range/Perf Bank1 Sensor 1
P2081 Exhaust Gas Temp Sensor Circ Interm Bank1 Sensor 1
P2082 Exhaust Gas Temp Sensor Circ Range/Perf Bank2 Sensor 1
P2083 Exhaust Gas Temp Sensor Circ Interm Bank2 Sensor 1
P2084 Exhaust Gas Temp Sensor Circ Range/Perf Bank1 Sensor 2
P2085 Exhaust Gas Temp Sensor Circ Interm Bank1 Sensor 2
P2086 Exhaust Gas Temp Sensor Circ Range/Perf Bank2 Sensor 2
P2087 Exhaust Gas Temp Sensor Circ Interm Bank2 Sensor 2
P2088 A Camshaft Pos Actuator Ctrl Circ Low Bank1
P2089 A Camshaft Pos Actuator Ctrl Circ High Bank1 
P2090 B Camshaft Pos Actuator Ctrl Circ Low Bank1
P2091 B Camshaft Pos Actuator Ctrl Circ High Bank1
P2092 A Camshaft Pos Actuator Ctrl Circ Low Bank2
P2093 A Camshaft Pos Actuator Ctrl Circ High Bank2
P2094 B Camshaft Pos Actuator Ctrl Circ Low Bank2
P2095 B Camshaft Pos Actuator Ctrl Circ High Bank2
P2096 Post Catalyst Fuel Trim Sys Too Lean Bank1
P2097 Post Catalyst Fuel Trim Sys Too Rich Bank1
P2098 Post Catalyst Fuel Trim Sys Too Lean Bank2
P2099 Post Catalyst Fuel Trim Sys Too Rich Bank2 
P2100 Throttle Actuator Ctrl Motor Circ/Open
P2101 Throttle Actuator Ctrl Motor Circ Range/Perf
P2102 Throttle Actuator Ctrl Motor Circ Low
P2103 Throttle Actuator Ctrl Motor Circ High



B.U.D.S. User Manual User interface > Faults

  139www.diag-systems.com

P2104 Throttle Actuator Ctrl Sys-Forced Idle
P2105 Throttle Actuator Ctrl Sys-Forced Engine Shutdown
P2106 Throttle Actuator Ctrl Sys-Forced Limited Power
P2107 Throttle Actuator Ctrl Mod Processor
P2108 Throttle Actuator Ctrl Mod Perf
P2109 Throttle/Pedal Pos SensorA Minimum Stop Perf 
P2110 Throttle Actuator Ctrl Sys-Forced Limited RPM
P2111 Throttle Actuator Ctrl Sys-Stuck Open
P2112 Throttle Actuator Ctrl Sys-Stuck Closed
P2113 Throttle/Pedal Pos SensorB Minimum Stop Perf
P2114 Throttle/Pedal Pos Sensor C Minimum Stop Perf
P2115 Throttle/Pedal Pos Sensor D Minimum Stop Perf
P2116 Throttle/Pedal Pos Sensor E Minimum Stop Perf
P2117 Throttle/Pedal Pos Sensor F Minimum Stop Perf
P2118 Throttle Actuator Ctrl Motor Current Range/Perf
P2119 Throttle Actuator Ctrl Throttle Body Range/Perf 
P2120 Throttle/Pedal Pos Sensor/Switch D Circ
P2121 Throttle/Pedal Pos Sensor/Switch D Circ Range/Perf
P2122 Throttle/Pedal Pos Sensor/Switch D Circ Low Input
P2123 Throttle/Pedal Pos Sensor/Switch D Circ High Input
P2124 Throttle/Pedal Pos Sensor/Switch D Circ Interm
P2125 Throttle/Pedal Pos Sensor/Switch E Circ
P2126 Throttle/Pedal Pos Sensor/Switch E Circ Range/Perf
P2127 Throttle/Pedal Pos Sensor/Switch E Circ Low Input
P2128 Throttle/Pedal Pos Sensor/Switch E Circ High Input
P2129 Throttle/Pedal Pos Sensor/Switch E Circ Interm 
P2130 Throttle/Pedal Pos Sensor/Switch F Circ
P2131 Throttle/Pedal Pos Sensor/Switch F Circ Range Perf
P2132 Throttle/Pedal Pos Sensor/Switch F Circ Low Input
P2133 Throttle/Pedal Pos Sensor/Switch F Circ High Input
P2134 Throttle/Pedal Pos Sensor/Switch F Circ Interm
P2135 Throttle/Pedal Pos Sensor/Switch A / B Voltage Correlation
P2136 Throttle/Pedal Pos Sensor/Switch A / C Voltage Correlation
P2137 Throttle/Pedal Pos Sensor/Switch B / C Voltage Correlation
P2138 Throttle/Pedal Pos Sensor/Switch D / E Voltage Correlation
P2139 Throttle/Pedal Pos Sensor/Switch D / F Voltage Correlation 
P2140 Throttle/Pedal Pos Sensor/Switch E / F Voltage Correlation
P2141 Exhaust Gas Recirculation Throttle Ctrl Circ Low
P2142 Exhaust Gas Recirculation Throttle Ctrl Circ High
P2143 Invalid Data From Body Ctrl Mod A
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History page 
The History page provides functions that you can use to read and clear module historical data.  Depending on the 
type of vehicle, the following history sub-pages may be available:

Last 30 Seconds
Last Minute
Minimum / Maximum
Run Time
RPM Profile
Part Replacement
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Last 30 Seconds 
The Last 30 Seconds sub-page from the History page displays the snapshots recorded every 5 seconds by the MPEM 
during the last 30 seconds of engine running.

To clear the last 30 seconds page
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the Last 30 Seconds sub-page thumbnail.
4. Click on the Clear Last 30 Seconds button.
5. Click on the message box OK button.
6. Wait until B.U.D.S. clears the data into the MPEM.

Note
The clear is done simultaneously in the MPEM and in the document.
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Last Minute 
The Last Minute sub-page from the History page displays the 120 snapshots recorded every half second by the ECM 
during the last 60 seconds of engine running.

To clear the last minute page
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the Last Minute sub-page thumbnail.
4. Click on the Clear Last Minute button.
5. Click on the message box OK button.
6. Wait until B.U.D.S. clears the data into the ECM.

Note
The clear is done simultaneously in the ECM and in the document.
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Minimum / Maximum 
The Minimum / Maximum sub-page from the History page displays the minimum and maximum values recorded by 
the module.

To clear the minimum and maximum history table
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the Minimum / Maximum sub-page thumbnail.
4. Click on the Clear Min / Max button.
5. Click on the message box OK button.
6. Wait until B.U.D.S. clears the data into the module.

Note
The clear is done simultaneously in the module and in the document.
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Run Time
The Run Time sub-page from the History page shows a graphical representation of the amount of time the engine 
spent in normal mode and limp home mode.  For some vehicles, the time spent in learning mode is also available.

To view the run time history
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the Run Time sub-page thumbnail.
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RPM Profile 
The RPM Profile sub-page from the History page shows a graphical representation of the engine RPM profile.

To view the RPM profile
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the RPM Profile sub-page thumbnail.
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Part Replacement
The Part Replacement page provides functions that you can use to read, add and clear(*) parts to (from) the replacement 
history.  Each part in the replacement history is assigned a type (ECM, MPEM or Engine), a serial number and the 
vehicle hours it was added at.
To add an engine to the replacement history

When you change the engine serial number in the Vehicle page, B.U.D.S. automatically updates the Part Replacement 
page with the old engine serial number and the vehicle hours it was changed at.  If needed, you can also manually add 
an engine to the part replacement history.  To do so, follow these steps:
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the Part Replacement sub-page thumbnail.
4. Click on the Add Part in History button to open the Add Part in History window.
5. In the Add Part in History window, click on the Part Type zone Engine button.
6. Enter the part serial number in the Serial Number zone.
7. Click on the OK button.
8. Write MPEM document into the vehicle.

To add a MPEM to the replacement history
When replacing a MPEM with the Replace command from the Module | MPEM menu, B.U.D.S. automatically 
updates the Part Replacement page with the old MPEM serial number and the vehicle hours it was changed at.  If 
needed, you can also manually add a MPEM to the part replacement history.  To do so, follow these steps:
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the Part Replacement sub-page thumbnail.
4. Click on the Add Part in History button to open the Add Part in History window.
5. In the Add Part in History window, click on the Part Type zone MPEM button.
6. Enter the part serial number in the Serial Number zone.
7. Click on the OK button.
8. Write MPEM document into the vehicle.

* - only with privilege Megatech.

To add an ECM to the replacement history
When replacing a ECM with the Replace command from the Module | ECM menu, B.U.D.S. automatically updates 
the Part Replacement page with the old ECM serial number and the vehicle hours it was changed at.  If needed, you 
can also manually add a ECM to the part replacement history.  To do so, follow these steps:
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the Part Replacement sub-page thumbnail.
4. Click on the Add Part in History button to open the Add Part in History window.
5. In the Add Part in History window, click on the Part Type zone ECM button.
6. Enter the part serial number in the Serial Number zone.
7. Click on the OK button.
8. Write MPEM document into the vehicle.

To add a cluster to the replacement history
When adding manually a cluster to the part replacement history, follow these steps:
1. Read MPEM document from the vehicle.
2. Click on the History page thumbnail.
3. Click on the Part Replacement sub-page thumbnail.
4. Click on the Add Part in History button to open the Add Part in History window.
5. In the Add Part in History window, click on the Part Type zone Cluster button.
6. Enter the part serial number in the Serial Number zone.
7. Click on the OK button.
8. Write MPEM document into the vehicle.
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Logon Window 
B.U.D.S. provides a Logon window that is automatically displayed when you start the software.  The logon window 
contains two pages:  the Technician page that you use to log on B.U.D.S. and the Date and Time page that you can use 
to set your computer local date and time.

To log on B.U.D.S.
1. Click on the Technician page thumbnail.

2.
Select your technician name from the Username drop down list.  If you can’t find your 
name in the list, then ask your administrator to register a username for you.

3. Type your password in the Password zone.  Note that the password is not case sensitive.
4. Click on the OK button to logon or the Cancel button to exit B.U.D.S..

To change your computer’s date
1. Click on the Date and Time page thumbnail.
2. Click on Local Date drop down list to open the calendar.
3. Click on the left and right arrows to navigate through the months.
4. Click a number of the calender to select the date.
5. Verify the date that you selected in the Local Date zone.
6. Click on the Apply button to set the new date into your computer.

To change your computer’s time
1. Click on the Date and Time page thumbnail.
2. In the Local Time zone:

Select the hours and click on the right end arrows to increase or decrease the value.
Select the minutes and click on the right end arrows to increase or decrease the value.
Select the seconds and click on the right end arrows to increase or decrease the value.

3. Click on the Apply button to set the new time into your computer.
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Starting the engine
B.U.D.S. provides a function that you can use to enable a RFI engine to start with the DESS® adapter connected to 
the vehicle.

To enable a RFI engine to start
1. Click on the toolbar Starting button.

2.
Specify the maximum speed that you want the engine to run at and then click on the OK 
button.  Maximum engine speed must be between 1500 and 7080 RPM.

3. Follow the instructions provided by B.U.D.S..
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Stop engine
On some vehicles, B.U.D.S. provides a function that you can use to stop the engine.

To stop the engine
Click on the toolbar Stop button or hit the keyboard space bar.

Note
After the engine is stopped, B.U.D.S. automatically reads the history from the module to ensure that the History page 
contains the latest information available.  However, on a RFI vehicle you are responsible for updating the document 
history, using the Refresh button of the History page.
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ECM Tracking 
The ECM stores received data in its volatile memory first.   In other words, if power is disconnected from the ECM 
immediatly after you sent new data, then it would be lost.  To force the ECM to store received data in its non-volatile 
memory, you must initiate the so called »ECM tracking« procedure.

To initiate the ECM tracking procedure
Whenever you send new data to the ECM, B.U.D.S. displays the ECM Tracking message.  When you see this message 
then:
1. Remove the key from the vehicle DESS® post.
2. Wait until the ECM Tracking message disappears from the screen.

To postpone the ECM tracking procedure
1. Press the Ignore button.

2.
When you will close the document or quit the application, then B.U.D.S. will remind you 
to initiate the ECM Tracking procedure.
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Vehicle Model Missing 
The Vehicle Model Missing window is automatically displayed when B.U.D.S. cannot determine the type of vehicle you 
are connected to because the vehicle model is missing.

To enter the vehicle model
1. Read MPEM document from the vehicle.
2. Type the vehicle model number in the Model zone.
3. Click on the OK button to view the modified MPEM document.
4. If the document does not match the connected vehicle then:

Close MPEM document and loose your modification.
Go back to step 1.

5. If the document matches the connected vehicle then:
Write MPEM document into the vehicle.

Note
The vehicle model must either be »SBOAT«, an alphanumerical value or an entirely numerical value.



B.U.D.S. User ManualTroubleshooting

  152 www.diag-systems.com

Using help
B.U.D.S. provides help topics that you can use to solve utilization problems or learn more about the software.  The 
topics can be browsed using the standard Windows help browser.  B.U.D.S. also provides links that you can use to 
directly open the topics related to the interface component that you are working with.
To open the help browser
Select Topics from the Help menu or click on the Help button from the toolbar.

To open a specific topic

1.
Select What’s This? from the Help menu.  Note that the cursor shape changes to an 
arrow with a question mark.

2. Click on the interface component that you want to open the topic of.

Note
If the interface component that you want to open the topic of is a button or an edit zone, then you can also press the 
F1 key to perform the same action.
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MPI not present 
When B.U.D.S. considers that the MPI is not present then it displays the following icon in the status bar:

To find out why the MPI is not present

If you think that B.U.D.S. should see the MPI, then scan the following checklist:
1. Is the MPI properly connected to the computer ?
2. Is the MPI properly powered ?

3.
If B.U.D.S. still considers that the MPI is not present then reset
the MPI.
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Module not present
When B.U.D.S. considers that no module is present then it displays the following icon in the status bar:

To find out why no module is present

If you think that B.U.D.S. should see a module, then scan the following checklist:
1. Is the appropriate communication protocol selected ?
2. Is the module properly connected (VCK, MPI-2) to the MPI® ?
3. Is the battery voltage correct or is the module properly powered ?
4. Is this version of B.U.D.S. compatible with the module ?
5. If B.U.D.S. still considers that no module is present then:

Disconnect the vehicle’s DESS® post key or adapter, wait a few seconds and then
reconnect it.  You may have to momentarilly press the vehicle’s start button.
On snowmobile MPEM, disconnect power supply adapter and reconnect it.
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Error 001:  Could not find dealer number in the B.U.D.S. 
installation folder 
Upon startup, B.U.D.S. looks into its installation folder to find the dealer name and number that your administrator 
typed in during the installation of the software.  If B.U.D.S. can't find your dealer name and number, then it shows the 
above message.

Possible cause
The dealer name and number storage file »BUDS.dat« has been accidentally altered or destroyed.

Suggested action
Ask your administrator to reinstall B.U.D.S..

Note
If you reinstall B.U.D.S., none of your MPEM documents that you may have saved into the directory where B.U.D.S. is 
installed will be destroyed.
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Error 002:  The communication library is obsolete or 
corrupted
Upon startup, B.U.D.S. loads the library file »commvrb.dll« that contains all the functions used to communicate with 
a module.  B.U.D.S. searches for the library file in the following sequence:
1. The directory from which B.U.D.S. is loaded.
2. The current directory.
3. The Windows system directory.
4. The Windows directory.
5. The directories that are listed in the PATH environment variable.
If the library file found during the search sequence is corrupted or obsolete, then B.U.D.S. shows the message above.

Possible causes
1. B.U.D.S. tries to load an older version of the communication library.
2. The communication library has been corrupted.

Suggested actions
1. Launch B.U.D.S. from the Start menu.
2. Reinstall B.U.D.S..
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Error 003:  The communication library was not found
Upon startup, B.U.D.S. loads the library file »commvrb.dll« that contains all functions used to communicate with a 
module.  B.U.D.S. searches for the library file in the following sequence:
1. The directory from which B.U.D.S. is loaded.
2. The current directory.
3. The Windows system directory.
4. The Windows directory.
5. The directories that are listed in the PATH environment variable.
If B.U.D.S. cannot find the communication library in none of the above directories, then it shows the message above.
Possible causes
1. B.U.D.S. loaded the library file from an earlier version directory.
2. The file “commvrb.dll” was accidentally deleted.
Suggested actions
1. Launch B.U.D.S. from the Start menu.

2.
Make sure that the library file “commvrb.dll” is in the directory where “BUDS.exe” 
resides.

3. Reinstall B.U.D.S..
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Error 201:  Bad data transfer between your computer 
and the module
B.U.D.S. was expecting a particular data from the module but did not receive it or received something else.
Possible causes
1. Bad connection between the MPI® and your computer.
2. Bad connection between the MPI and the module.
3. The module did not recognize your command.
4. Electrical noise on communication lines.

Suggested actions
1. Verify connections between your computer, the MPI and the module.

2.
If you are using a DESS® adapter, maintain a light pressure on it with your hand while 
executing the command.

3. Try the command again.
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Error 202:  Data corrupted during transfer between your 
computer and the MPI®
B.U.D.S. received all the data that it was expecting from the MPI, but some of it was corrupted.

Possible causes
1. Bad connection between the MPI and your computer.
2. Electrical noise on communication lines.

Suggested actions
1. Verify the connections between the MPI and your computer.

2.
If you are using a DESS® adapter, maintain a light pressure on it with your hand while 
executing the command.

3. Try the command again.
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Error 203:  The MPI® protocol software was lost
The MPI has lost the protocol software that B.U.D.S. loaded upon startup.
Possible causes
1. MPI power source failure.

2.
Bad connection between the MPI and your 
computer.

Suggested actions
1. Verify the MPI power sources.

2.
Verify the connections between the MPI and your 
computer.

3. Reset the MPI.
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Error 204:  A communication function was called with 
erroneous parameters
The MPI® received a command that had erroneous parameters.

Possible causes
1. Manipulation error.
2. Internal B.U.D.S. software failure.

Suggested actions
1. Try the command again.

2.
Call your service representative to report the 
error.
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Error 205:  No MPEM was detected
The MPI® did not detect the MPEM presence signal.

Possible causes

1.
Bad connection between the MPI and the 
MPEM.

2. MPEM internal power switch is off.
3. MPEM power source failure.
4. Electrical noise on communication lines.

Suggested actions

1.

If you are using a DESS® adapter, remove the adapter from the vehicle DESS post, wait 
for few seconds and then insert the adapter again.  Maintain a light pressure on the 
adapter with your hand while executing the command.

2. On snowmobile MPEM, disconnect power supply adapter and reconnect it.
3. Verify the MPEM power source voltage.
4. Verify all connections between the MPI and the MPEM/ECM (VCK, MPI-2).
5. Try the command again.
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Error 206:  No MPI® was detected
B.U.D.S. did not detect the MPI on the serial port it was connected to.

Possible causes
1. Bad connection between your computer and the MPI.
2. MPI power source failure.

Suggested actions
1. Verify all the connections between your computer and the MPI.
2. Verify the MPI power sources.
3. Try the command again.
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Error 250:  MPI® DESS® post data corrupted
The data that the MPI read from its DESS post was corrupted.

Possible causes
1. The key contacts are rusted or dirty.
2. The key is defective.
3. The MPI is defective.

Suggested actions
1. Maintain a light pressure with your hand on the key while reading it.
2. Try to read the key again.
3. Insert another key on the MPI DESS post.
4. Replace the MPI.
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Error 251:  Short circuit key
The key inserted on the MPI® DESS® post is shorted.

Possible causes
1. The key contacts are rusted or dirty.
2. The key is defective.
3. The MPI is defective.

Suggested actions
1. Clean the key contacts.
2. Try to read the key again.
3. Insert another key on the MPI DESS post.
4. Replace the MPI.
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Error 252:  Open circuit key
The key inserted on the MPI® DESS® post is opened.

Possible causes
1. The key is not completely inserted on the DESS post.
2. The key contacts are rusted or dirty.
3. The key is a DIAGNOSTIC key.
4. The key is defective.
5. The MPI is defective.

Suggested actions
1. Make sure that the key is completely inserted on the MPI DESS post.
2. Maintain a light pressure with your hand on the key.
3. Clean the key contacts.
4. Try to read the key again.
5. Insert another key on the MPI DESS post.
6. Replace the MPI.
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Error 255:  No device present on the MPI® DESS® post
B.U.D.S. tried to read a key from the MPI DESS post, but the MPI did not see it.

Possible causes
1. The key is not completely inserted on the DESS post.
2. The key is defective.
3. The MPI is defective.

Suggested actions
1. Make sure that the key is completely inserted on the MPI DESS post.
2. Insert another key on the MPI DESS post.
3. Try to read the key again.
4. Replace the MPI.
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Errors 300-308:  947-DI protocol communication failure
The MPI® detected an error while communicating with the MPEM using the 947-DI protocol.

Possible causes
1. MPEM internal power switch is off.
2. MPEM power source failure.
3. Bad connection between the MPI and the MPEM.
4. Electrical noise on communication lines.
5. Incompatible MPI software revision.

Suggested actions
1. Remove the key from the vehicle DESS® post, wait for few seconds and then insert the key again.
2. Verify the MPEM power source voltage.
3. Verify all connections between the MPI and the MPEM/ECM (VCK, MPI-2).
4. Ask your administrator for a B.U.D.S. software upgrade.
5. Try the command again.
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Errors 350-353:  DESS® protocol communication failure
The MPI® detected an error while communicating with the MPEM using the DESS protocol.

Possible causes
1. MPEM internal power switch is off.
2. MPEM power source failure.
3. Bad connection between the MPI and the MPEM.
4. Electrical noise on communication lines.
5. Incompatible MPI software revision.

Suggested actions
1. Remove the adapter from the vehicle DESS post, wait for few seconds and then insert the adapter again.
2. On snowmobile MPEM, disconnect power supply adapter and reconnect it.
3. Verify the MPEM power source voltage.
4. Verify all connections between the MPI and the MPEM/ECM (VCK, MPI-2).
5. Ask your administrator for a B.U.D.S. software upgrade.
6. Try the command again.
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Errors 400-403:  Kw2000 protocol communication failure
The MPI® detected an error while communicating with B.U.D.S. using the Kw2000 protocol.

Possible causes
1. Bad connection between the MPI and your computer.
2. Electrical noise on communication lines.
3. Internal MPI software failure.
4. Internal B.U.D.S. error.

Suggested actions
1. Verify the connections between the MPI and your computer.
2. Try the command again.
3. Reset the MPI.
4. Call your service representative to report the error.
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Errors 404-411:  Kw2000 protocol communication failure
The MPI® detected an error while communicating with a module using the Kw2000 protocol.

Possible causes
1. Module power source failure.
2. Bad connection between the MPI and the module.
3. Electrical noise on communication lines.
4. Internal MPI failure.
5. Internal module failure.

Suggested actions
1. Remove the key from the vehicle DESS® post until B.U.D.S. considers that no module is present and then

insert the key again.  You may have to momentarilly press the vehicle's start button.
2. Verify the module's power source voltage.
3. Verify all connections between the MPI and the module (VCK, MPI-2).
4. Try the command again.
5. Reset the MPI.
6. Call your service representative to report the error.
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Error 500:  Diagnostic function failure
The MPEM indicates that the diagnostic function that you initiated failed.

Possible cause

Internal MPEM failure.

Suggested actions
1. Try the command again.
2. Call your service representative to report the error.
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Error 501:  Diagnostic function can't be initiated while 
the engine is running
The MPEM indicates that you have tried to initiate a diagnostic function while the engine was running.

Suggested action

Stop the engine and then try the function again.
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Error 502:  Diagnostic function privilege error
The MPEM indicates that you don't have enough privileges to initiate the requested diagnostic function.

Suggested action

Accept the refusal with humility !
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Error 503:  Diagnostic function internal parameter error
The MPEM indicates that B.U.D.S. initiated a diagnostic function with erroneous parameters.

Possible cause

Internal B.U.D.S. error.

Suggested action

Call your service representative to report the error.
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Error 504:  Diagnostic function manager is busy
Your diagnostic function request failed because the MPEM is busy.

Suggested actions
1. Unlock the ignition offset angle if it is locked.
2. Make sure that no other diagnostic function is running.
3. Try the function again.
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Errors 505 and 507:  Diagnostic function is not supported
The MPEM indicates that the diagnostic function that you initiated is not supported.

Possible cause

You are connected to an old MPEM that does not support new diagnostic functions.

Suggested action

Stop using the function when connected to this old MPEM.
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Error 506:  Diagnostic function is already in progress
The MPEM indicates that the diagnostic function that you initiated is already in progress.

Suggested action

Wait for the diagnostic function to terminate and then try it again.
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Error 508:  Diagnostic function status not available
The MPEM indicates that B.U.D.S. asked for the status of a diagnostic function that was not running.

Possible cause

Internal B.U.D.S. error.

Suggested actions
1. Shut down the MPEM for few seconds by removing the key from the vehicle DESS® post.
2. Reinsert the key into the vehicle DESS post.
3. Read the document from the vehicle.
4. Try the function again.
5. Call your service representative to report the error.



B.U.D.S. User ManualTroubleshooting

  180 www.diag-systems.com

Error 509:  Diagnostic function hardware does not exist
The MPEM indicates that the diagnostic function that you initiated has no hardware attached to it.

Possible cause

You are connected to an old MPEM.

Suggested action

Stop using the function when connected to this old MPEM.



B.U.D.S. User Manual Troubleshooting

  181www.diag-systems.com

Error 510:  Diagnostic function was running but suddenly 
failed
The MPEM indicates that the diagnostic function that you initiated was running, but suddenly failed during the 
execution.

Possible causes
1. The MPEM input sensor is out-of-range.
2. The MPEM output driver circuit failed.
3. The target component is defective.
4. The software inside the MPEM failed.

Suggested actions
1. Make sure that the input value is within a valid range.

If you are resetting the closed TPS, then make sure that the idle speed screw is in contact with the throttle 
plate stopper and try the command again.

2. Make sure that the target component is not defective.
3. Try the command again.
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Error 550:  Communication error between the MPEM 
and the RFI engine module
The data that B.U.D.S. received from the RFI engine module was corrupted or incomplete.

Possible causes
1. Electrical noise on the communication lines.
2. Bad connection between the PC and the MPEM.
3. Incompatible software version into the RFI engine module.

Suggested actions
1. Try the command again.
2. Remove the key from the vehicle DESS® post, wait for few seconds and then insert the key again.
3. Verify all connections between the PC and the MPEM/ECM (VCK, MPI-2).
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Error 551:  RFI engine module start function failure
B.U.D.S. considers that the RFI engine module start function failed.

Possible causes
1. Electrical noise on the communication lines.
2. Bad connection between the PC and the MPEM.
3. Incompatible software version into the RFI engine module.

Suggested actions
1. Remove the key from the vehicle DESS® post, wait for few seconds and then insert the key again.
2. Verify all connections between the PC and the MPEM/ECM (VCK, MPI-2).
3. Try the command again.
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Error 552:  RFI engine module stop engine function 
failure
B.U.D.S. considers that the RFI engine module stop function failed.

Possible causes
1. Electrical noise on the communication lines.
2. Bad connection between the PC and the MPEM.
3. Incompatible software version into the RFI engine module.

Suggested actions
1. If you need to stop the engine right away, press the vehicle start/stop button.
2. Verify all connections between the PC and the MPEM/ECM (VCK, MPI-2).
3. Try the command again.
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Error 553:  RFI engine module real-time initialization 
failure
B.U.D.S. considers that the RFI engine module real-time initialization function failed.

Possible causes
1. Electrical noise on the communication lines.
2. Bad connection between the PC and the MPEM.
3. Incompatible software version into the RFI engine module.

Suggested actions
1. Remove the key from the vehicle DESS® post, wait for few seconds and then insert the key again.
2. Verify all connections between the PC and the MPEM/ECM (VCK, MPI-2).
3. Try the command again.
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Error 554:  RFI engine module parameter programming 
failure
B.U.D.S. considers that the RFI engine module did not successfully write the new parameter into its memory.

Possible causes
1. Electrical noise on the communication lines.
2. Bad connection between the PC and the MPEM.
3. Incompatible software version into the RFI engine module.

Suggested actions
1. Remove the key from the vehicle DESS® post, wait for few seconds and then insert the key again.
2. Verify all connections between the PC and the MPEM/ECM (VCK, MPI-2).
3. Try the command again.
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Error 200:  No serial port available
B.U.D.S. could not open any of your computer's serial port for communicating with the MPI®.

Possible causes
1. Your computer serial ports are all used by other applications.
2. Your type of computer serial ports are not supported by B.U.D.S..
3. Your computer serial ports are defective.

Suggested actions
1. Connect the MPI to another serial port.
2. Close all applications that may use the serial ports.
3. Restart your computer in order to reinitialize the serial ports.
4. Make sure that your computer serial ports are based on one the following UART:

8250 / 16450 / 16550 / 16650 / 16750 or 16850.
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